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Read This First

Welcome to the Thermo Scientific Orbitrap Elite system! The 
Orbitrap Elite mass spectrometer is a member of the family of LTQ™ 
mass spectrometer (MS) detectors.

About This Guide
This Orbitrap Elite Getting Started manual provides information on how 
to set up, calibrate, and tune the Orbitrap Elite mass spectrometer. 
Procedures in Chapters 1–4 can be performed from the Xcalibur™ Tune 
Plus window.

Who Uses This Guide

This Orbitrap Elite Getting Started manual is intended for all personnel 
that need to operate the Orbitrap Elite mass spectrometer, especially the 
key operator. This manual should be kept near the instrument to be 
available for quick reference.

Scope of This Guide

Orbitrap Elite Getting Started includes the following chapters:

• Chapter 1: “Introduction” provides general information about this 
manual. 

• Chapter 2: “Tune Plus Window” provides information on the Tune 
Plus window.

• Chapter 3: “Calibrating the Instrument for FTMS Measurements” 
provides procedures to calibrate the Orbitrap Elite mass 
spectrometer for FTMS measurements.

• Chapter 4: “Performing Diagnostics/Checks” describes several 
diagnostic procedures.

• Chapter 5: “Instrument Setup” describes the FTMS relevant topics 
of the data dependent settings in the Instrument Setup.

• Chapter 6: “Instrument Configuration” gives instructions about 
configuring the instrument.
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• Chapter 7: “Orbitrap Elite ETD Instruments”describes the Orbitrap 
analyzer relevant differences in instrument settings and procedures 
with respect to using a Orbitrap Elite ETD instrument.

• Appendix A: “Miscellaneous Information” gives additional 
information about various topics.
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Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the 
following documents for Orbitrap Elite and Orbitrap Elite ETD mass 
spectrometers:

• LTQ Orbitrap Series Preinstallation Requirements Guide

• Orbitrap Elite Hardware Manual

• Velos Pro manual set

You can access PDF files of the documents listed above and of this guide 
from the data system computer. The software also provides Help.

❖ To view product manuals

1. From the Microsoft™ Windows™ taskbar, choose Start > Programs 
> Thermo Instruments > Manuals > model.

2. Click the PDF file that you want to view. 
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Contacting Us
There are several ways to contact Thermo Fisher Scientific.

Assistance

For technical support and ordering information, visit us on the Web:

www.thermoscientific.com/ms

Service contact details for customers in Europe are available under:

www.thermoscientific.com/euservicecontact

Customer Information Service

cis.thermo-bremen.com is the Customer Information Service site aimed 
at providing instant access to

• Latest software updates

• Manuals, application reports, and brochures

Thermo Fisher Scientific recommends that you register with the site as 
early as possible. To register, visit register.thermo-bremen.com/form/cis 
and fill in the registration form. Once your registration has been 
finalized, you will receive confirmation by e-mail.

Changes to the Manual

❖ To suggest changes to this manual

• Please send your comments (in German or English) to:

Editors, Technical Documentation
Thermo Fisher Scientific (Bremen) GmbH
Hanna-Kunath-Str. 11

28199 Bremen

Germany

• Send an e-mail message to the Technical Editor at

documentation.bremen@thermofisher.com

You are encouraged to report errors or omissions in the text or index.
Thank you.

http://www.thermoscientific.com/ms
http://www.thermoscientific.com/euservicecontact
http://cis.thermo-bremen.com/
http://register.thermo-bremen.com/form/cis
mailto:documentation.bremen@thermofisher.com
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Typographical Conventions
This section describes typographical conventions that have been 
established for Thermo Fisher Scientific manuals.

Data Input

Throughout this manual, the following conventions indicate data input 
and output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is identified by quotation marks: 
single quotes for single characters, double quotes for strings.

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled 
F1.

• Any command that requires pressing two or more keys 
simultaneously is shown with a plus sign connecting the keys. For 
example, “press <Shift> + <F1>” means press and hold the <Shift> 
key and then press the <F1> key.

• Any button that you click on the screen is represented in bold face 
letters. For example, “click Close”.

Topic Headings

The following headings are used to show the organization of topics 
within a chapter:

Chapter 1 Chapter Name

Second Level Topics

Third Level Topics

Fourth Level Topics
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Safety and EMC Information
In accordance with our commitment to customer service and safety, 
these instruments have satisfied the requirements for the European CE 
Mark including the Low Voltage Directive.

Designed, processed, and tested in an ISO9001 registered facility, this 
instrument has been shipped to you from our manufacturing facility in a 
safe condition.

This instrument must be used as described in this manual. Any use of 
this instrument in a manner other than described here may result in 
instrument damage and/or operator injury.

Notice on Lifting and Handling of Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the 
physical handling of this Thermo Scientific instrument requires a team 
effort for lifting and/or moving the instrument. This instrument is too 
heavy and/or bulky for one person alone to handle safely.

Notice on the Proper Use of Thermo Scientific Instruments

In compliance with international regulations: If this instrument is used 
in a manner not specified by Thermo Fisher Scientific, the protection 
provided by the instrument could be impaired.

Notice on the Susceptibility to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic 
environment. Do not use radio frequency transmitters, such as mobile 
phones, in close proximity to the instrument.

Safety and Special Notices

Make sure you follow the precautionary statements presented in this 
guide. The safety and other special notices appear different from the 
main flow of text. Safety and special notices include the following:

Caution Cautions highlight information necessary to protect your 
instrument from damage. ▲

Note Notes highlight information that can affect the quality of your 
data. In addition, notes often contain information that you might need 
if you are having trouble. ▲

Warning Warnings highlight hazards to human beings. Each Warning is 
accompanied by a Warning symbol. ▲
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Identifying Safety Information

This guide contains precautionary statements that can prevent personal 
injury, instrument damage, and loss of data if properly followed. 
Warning symbols alert the user to check for hazardous conditions. These 
appear throughout the manual, where applicable. The most common 
warning symbols that appear in Thermo Fisher Scientific manuals are 
shown below.

In addition, every instrument has specific hazards. So, be sure to read 
and comply with all precautions described in this guide. They will help 
ensure the safe, long-term use of your system.

General Safety Precautions

Observe the following safety precautions when you operate or perform 
service on your instrument:

• The system should be operated by trained personnel only. Read the 
manuals before starting the system and make sure that you are 
familiar to the warnings and safety precautions!

• Accurate results can be obtained only, if the system is in good 
condition and properly calibrated.

Warning General Hazard. This general symbol indicates that a hazard 
is present that could result in injuries if it is not avoided. 
The source of danger is described in the accompanying text. ▲

Warning Electric Shock Hazard. High Voltages capable of causing 
personal injury are used in the instrument. The instrument must be shut 
down and disconnected from line power before service is performed. Do 
not operate the instrument with the top cover off. Do not remove 
protective covers from PCBs. ▲

Warning Burn Hazard. Treat heated zones with respect. Parts of the 
instrument might be very hot and might cause severe burns if touched. 
Allow hot components to cool before servicing them. ▲

Warning Corrosive Material. Wear gloves when handling toxic, 
carcinogenic, mutagenic, or corrosive/irritant chemicals. Use approved 
containers and procedures for disposal of waste solution. ▲
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• Service by the customer should be performed by trained qualified 
personnel only and should be restricted to servicing mechanical 
parts! Service on electronic parts should be performed by Thermo 
Fisher Scientific field service engineers only!

• Before plugging in any of the instrument modules or turning on the 
power, always make sure that the voltage and fuses are set 
appropriately for your local line voltage.

• Only use fuses of the type and current rating specified. Do not use 
repaired fuses and do not short-circuit the fuse holder.

• The supplied power cord must be inserted into a power outlet with a 
protective earth contact (ground). When using an extension cord, 
make sure that the cord also has an earth contact.

• Do not change the external or internal grounding connections.
Tampering with or disconnecting these connections could endanger 
you and/or damage the system.

• The instrument is properly grounded in accordance with regulations 
when shipped. You do not need to make any changes to the 
electrical connections or to the instrument’s chassis to ensure safe 
operation.

• Never run the system without the housing on. Permanent damage 
can occur. When leaving the system, make sure that all protective 
covers and doors are properly connected and closed, and that heated 
areas are separated and marked to protect for unqualified personnel!

• Do not turn the instrument on if you suspect that it has incurred 
any kind of electrical damage. Instead, disconnect the power cord 
and contact a Thermo Fisher Scientific field service engineer for a 
product evaluation. Do not attempt to use the instrument until it 
has been evaluated. (Electrical damage may have occurred if the 
system shows visible signs of damage, or has been transported under 
severe stress.)

• Damage can also result if the instrument is stored for prolonged 
periods under unfavorable conditions (for example, subjected to 
heat, water, etc.).

• Always disconnect the power cord before attempting any type of 
maintenance.

• Capacitors inside the instrument may still be charged even if the 
instrument is turned off.

• Never try to repair or replace any component of the system that is 
not described in this manual without the assistance of your Thermo 
Fisher Scientific field service engineer.
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• Do not place any objects upon the instrument—especially not 
containers with liquids—unless it is requested by the user 
documentation. Leaking liquids might get into contact with 
electronic components and cause a short circuit.

Safety Advice for Possible Contamination

Hazardous Material Might Contaminate Certain Parts of Your 
System During Analysis.

In order to protect our employees, we ask you to adhere to special 
precautions when returning parts for exchange or repair.

If hazardous materials have contaminated mass spectrometer parts, 
Thermo Fisher Scientific can only accept these parts for repair if they 
have been properly decontaminated. Materials that due to their 
structure and the applied concentration might be toxic or that are 
reported in publications to be toxic are regarded as hazardous. Materials 
that will generate synergetic hazardous effects in combination with other 
present materials are also considered hazardous.

Your signature on the Health and Safety Form confirms that the 
returned parts have been decontaminated and are free of hazardous 
materials. Download the form from decon.thermo-bremen.com or 
order it from the Thermo Fisher Scientific field service engineer.

Parts contaminated by radioisotopes should not be returned to Thermo 
Fisher Scientific—neither under warranty nor within the exchange part 
program. If unsure about parts of the system possibly being 
contaminated by hazardous material, please make sure the Thermo 
Fisher Scientific field service engineer is informed before the engineer 
starts working on the system.

http://decon.thermo-bremen.com/
http://decon.thermo-bremen.com/
http://decon.thermo-bremen.com/
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Chapter 1 Introduction

This guide describes only the FTMS detector relevant settings and 
procedures of the Orbitrap Elite software (Tune Plus). For ion trap 
relevant settings and procedures, refer to the LTQ Series Getting Started 
manual.

In addition to this guide, the Tune Plus Help gives information to 
specific topics. Nevertheless, it is recommended to read this manual 
entirely.
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Chapter 2 Tune Plus Window

This chapter provides Orbitrap Elite mass spectrometer specific 
information about the Tune Plus window. It contains the following 
topics:

• “Introduction to Tune Plus” on page 2-2

• “View Menu” on page 2-3

• “Scan Mode Menu” on page 2-8

• “Display Menu” on page 2-15

• “Setup Menu” on page 2-16

• “Tune Methods” on page 2-21
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Introduction to Tune Plus
The Tune Plus window shows the schematic view of the Orbitrap Elite 
mass spectrometer and the instrument name. See Figure 2-1. 

To access the functions of the Tune Plus window, use the menu 
commands, toolbar buttons, and display views. The FT relevant changes 
or additions of the menu commands, toolbar buttons, and display views 
are explained in the following chapters.

Figure 2-1. Tune Plus window
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View Menu
This section describes those elements of the View menu that are 
different from the Velos Pro version of the Tune Plus window.

Spectrum View

The Spectrum view displays real-time ion trap or FT mass spectra 
depending on the analyzer type selected in the Define Scan dialog box. 
See Figure 2-2.

The Spectrum view page has a shortcut menu, which is displayed when 
you right-click anywhere on the page. To open the Spectrum Display 
Options dialog box, choose Display Options. The dialog box has two 
pages: the Ion Trap page and the FT page.

Use the FT page to determine the number of decimals shown on peak 
labels. See Figure 2-3 on page 2-4. To change the number of decimals, 
click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. You can set the number of decimals to any value 

Figure 2-2. Spectrum View page
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from 0 to 5. Alternatively, you can enter a value in the spin box text 
field. The Orbitrap Elite mass spectrometer changes the number of 
decimals when you click Apply or OK.

 

A check box allows showing additional analyzer information for 
FTMS scans. This information will be displayed above the spectrum 
graph if the box is selected. See “FT Analyzer Messages” on page A-3 for 
a list of items that may be displayed as analyzer information.

You can also decide whether or not to show the resolution and/or the 
charge state of peaks in the FT spectrum by clearing or selecting the 
corresponding check boxes.

If the FTMS analyzer is used, it is possible to display different diagnostic 
views in the Spectrum view. See Chapter 4: “Performing 
Diagnostics/Checks” for diagnostic features that involve the Spectrum 
view.

Figure 2-3. Spectrum Display Options dialog box—FT page
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Graph View

The Graph view displays, in a variety of traces, real-time data generated 
during calibration, tuning, and diagnostic tests. For example, the right 
side of Figure 2-4 shows the progress of the transfer efficiency 
evaluation.

Status View

The Status view displays real-time status information for the Orbitrap 
Elite mass spectrometer. See Figure 2-5 on page 2-6. The Status view has 
two pages: the All page and the User page. The All page displays the 
real-time status information for about 80 parameters of the Orbitrap 
Elite mass spectrometer. You can scroll through the list to observe the 
status of the parameters. The User page displays real-time status 
information for Orbitrap Elite mass spectrometer parameters that you 
have selected in the User Status Display Configuration dialog box. (See 
page 2-6.)

Figure 2-4. Graph view page
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User Status Display Configuration Dialog Box

Figure 2-6 on page 2-7 shows the User Status Display Configuration 
dialog box. 

❖ To configure the User page

1. Choose View > Display Status View.

2. Click the User tab. Right-click the User page to display the shortcut 
menu.

3. Choose Configure. The User Status Display Configuration dialog 
box is displayed. See Figure 2-6.

4. Select the check boxes that represent the status parameters you want 
to have displayed on the User page.

5. Click OK to close the dialog box. 

The User page displays real-time status information for the selected 
parameters.

Figure 2-5. Status view—All page
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Figure 2-6. User Status Display Configuration dialog box
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Scan Mode Menu
This section describes the elements of the Scan Mode menu that are 
different from the ion trap.

Define Scan

Choose Define Scan to display the Define Scan dialog box. The Define 
Scan dialog box allows defining a scan in various ways depending on the 
scan mode and scan type combination. Also, this dialog box allows 
choosing the ion trap or the Orbitrap (FTMS) as analyzer. Figure 2-7 
shows the Define Scan dialog box showing the Advanced Scan features. 
The Advanced Scan features can be activated in the Scan Mode menu of 
Tune plus.

Figure 2-7. Define Scan dialog box (Advanced Scan Features enabled)
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Scan Description

The Scan Description area contains the following elements:

Scan Time

The Scan Time area contains the following elements:

Analyzer At the top, the Analyzer list box allows selecting 
the analyzer type used during the currently 
selected scan event. The following options are 
available:

• FTMS selects the Orbitrap analyzer.

• Ion Trap selects the ion trap analyzer.
Mass Range The following mass ranges are available:

• Low: m/z 15–200 for ion trap analyzer only

• Normal: m/z 50–2000 for ion trap analyzer 
and FTMS analyzer

• High: m/z 100–4000 for ion trap analyzer 
and FTMS analyzer

Scan Rate / 
Resolution

When you have selected the entry Ion Trap in 
the Analyzer list box, this list box allows setting 
the scan rate (Normal, Rapid, Enhanced, Turbo, 
Zoom, UltraZoom).

When you have selected the entry FTMS in the 
Analyzer list box, this list box allows setting the 
resolution of the FT mass spectra. 
Available resolution settings (FWHM at 
m/z 400) are 15000, 30000, 60000, 120000, 
and 240000.

Scan Type Usage of the scan types Full MS, SIM, SRM, or 
CRM is analogous to the ion trap. However, 
only one scan range is available for FTMS SIM, 
FTMS SRM, and FTMS CRM scans.

Microscans The number of microscans determines how 
many spectra are averaged in one analytical scan. 
If FTMS is chosen as analyzer, transients are 
averaged for one analytical scan.

The number of microscans can be set 
individually for FTMS, Ion Trap MS, FTMS 
SIM, Ion Trap SIM, FT MSn, Ion Trap MSn, and 
Ion Trap Zoom.
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Max Inject Time The inject time is automatically controlled by the 
Automatic Gain Control™ (AGC™). The entry in 
this spin box limits the inject time to a maximum 
value. To ensure the high mass accuracy of the 
Orbitrap Elite mass spectrometer, the maximum 
inject time should not be reached. Otherwise, the 
number of ions does not correspond to the AGC 
target value.
The maximum inject time can be set individually 
for FTMS, Ion Trap MS, FTMS SIM, Ion Trap 
SIM, FT MSn, Ion Trap MSn, and Ion Trap 
Zoom.

Note If the maximum inject time is reached, the 
number of ions does not correspond to the 
current AGC target value. This may affect the 
mass accuracy of FTMS spectra. ▲

Scan Time Settings Click All to display the Scan Time Settings 
dialog box. See Figure 2-8. It allows displaying 
and setting all scan time settings for all scan types 
at the same time for both the ion trap and the 
FT analyzer.

Figure 2-8. Scan Time Settings dialog box—FT page
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Locking

Locking allows using one or more peaks in the spectrum as internal 
reference to improve mass accuracy. Locking is available for 
FTMS scans.

Select the On check box in the Locking area to enable locking. Then, 
click Masses to display a dialog box for entering and editing lock mass 
lists. See Figure 2-9.

Lock mass lists can consist of one or more lock masses. If the list 
contains lock masses that are (temporarily) not found in the spectrum, 
these lock masses are ignored (temporarily) and the instrument steps 
back to the external calibration. Thus, even when lock masses are used, 
the instrument should be external calibrated as well. For standard full 
scan experiments, it is expected that the spectrum shows at least one 
peak that corresponds to a lock mass.

There are two situations where the instrument makes use of a special 
mode to artificially mix the lock mass into the spectrum:

• If none of the given lock masses is found in the full spectrum, the 
instrument tries to improve the abundance of the lock mass by 
performing additional SIM injections of the specified lock mass. 

• If the given lock mass cannot be found in the spectrum because the 
instrument runs in MSn or SIM scan type, the instrument adds the 
lock mass by using SIM injections.

This way, lock masses can be used for all FTMS scan types and for 
varying lock mass abundances. There is no need for user interaction 
other than specifying a list of reference mass candidates.

Figure 2-9. Lock Masses dialog box
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Note Injection of lock masses is turned off completely, when you set the 
target value of the lock mass abundance to 0% on the Set device page of 
the Diagnostics dialog box. See page 4-13. ▲

See “FT Analyzer Messages” on page A-3 on how to view information 
about the instruments locking state. See “Using Locking in Automated 
Runs” on page 5-2 on how to set FTMS locking in Instrument Setup.

MSn Settings

The table in this area allows specifying the parameters for each segment 
of an MSn experiment.1

1This feature is available only for the Orbitrap Elite ETD mass spectrometer.

Act. Type The Activation Type list box becomes available 
when you enter a parent mass. It allows specifying 
how the ions are activated for fragmentation and 
has the following options:

• CID (Collision-induced dissociation)

• PQD (Pulsed-Q dissociation)

• ETD (electron transfer dissociation)1

Use ETD to fragment peptides and proteins.

• HCD (higher energy CID)

To use HCD you must select FTMS in the 
Analyzer list box. Use HCD to obtain triple 
quadrupole-like fragment ion spectra. HCD is 
available only for the final step in an 
MSn experiment—it is not possible to set up 
an experiment where the first activation 
method is HCD and the second method is 
CID, for example. If you enter a new step 
after an HCD experiment, Tune Plus will 
change it to a CID experiment.

Normalized 
Collision Energy

When ETD is selected in the Activation Type list 
box, the Normalized Collision Energy spin box is 
disabled. For ETD activation, no RF amplitude is 
used to fragment ions.1
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1Act. Q When HCD is selected in the Activation Type list 
box, the Activation Q spin box is disabled. For 
HCD activation, no Q value is used for 
calculating voltages or amplitudes.

The Activation Q spin box is also disabled for 
ETD activation.1

HCD Charge State The required absolute collision energy for the 
fragmentation of precursor ions depends on their 
charge states. A lower collision energy is required 
for higher charge states. The algorithm for 
calculating the absolute collision energy is based 
on empirical data taken from measurements on 
peptides. For example, the required absolute 
energy to fragment [M+2H]2+ ions is about 90% 
of that of the corresponding [M+H]+ ions. For 
[M+3H]3+ ions, the value goes down to 85%. 

To take advantage of this, enter the charge state of 
the ions to be fragmented into the spin box. To 
change the displayed value, click the arrows in the 
spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, you can 
enter a value in the spin box text field. You can set 
the HCD charge state to any value from 1 to 99. 
The default value is 1.
The HCD Charge State spin box is available only 
if HCD is selected as activation type, regardless of 
the status of the Advanced Scan features. See 
Figure 2-10.

1This feature is available only for the Orbitrap Elite ETD mass spectrometer.
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Scan Ranges

When HCD is selected as the activation method in the MSn Settings 
area, the First Mass (m/z) is set to either 0.05×LastMass or 100, 
whichever is higher.

Centroid/Profile

Use this pair of buttons to switch between the Centroid and the Profile 
format. The Profile format for FTMS data is a compressed Profile 
format. “FT Profile Mode” on page 4-10 describes how to switch to full 
Profile format for FTMS data for diagnostic purposes.

For further information, see also “Data Size of FT Raw Files” on 
page A-4.

Positive/Negative

Use this pair of buttons to switch between positive ion and negative ion 
polarity. Different FT transfer, storage, and mass calibration parameters 
are used for the different polarities.

Figure 2-10. Define Scan dialog box with HCD selected as activation type
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Display Menu
This section describes the elements of the Display menu that are 
different from the ion trap.

Spectrum Averaging

Use this toggle to switch on or off spectrum averaging. If spectrum 
averaging is enabled, the displayed spectrum is the moving average of 
several spectra before and is shown in red. Averaging FTMS scans is an 
averaging of transients. Use this functionality in analogy to ion trap 
scans.

❖ To average FTMS scans

1. In the Tune Plus window, choose Display > Spectrum Averaging > 
Settings… to display the Spectrum Averaging dialog box. See 
Figure 2-11.

2. Enter the number of transients to average into the spin box.

3. Click OK to save your changes and close the dialog box.

Figure 2-11. Spectrum Averaging dialog box
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Setup Menu
This section describes the elements of the Setup menu that are different 
from the Velos Pro version of the Tune Plus window.

FT Transfer Optics

The FT transfer parameters are only changed by an FT transmission 
calibration, which is usually only necessary when the hardware of the 
system has been modified. This dialog box displays the actual 
FTreadback values for the current scan mode. See Figure 2-12.

❖ To open the FT Transfer Optics dialog box

• From the Tune Plus window, choose Setup > FT Ion Optics, or

• click  in the Instrument Control toolbar.

Figure 2-12. FT Transfer Optics dialog box
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FT Injection Control

Use the Injection Control dialog box to set the automatic gain control 
(AGC) target values. In addition, the Injection Control dialog box 
allows enabling or disabling the injection waveforms.

❖ To open the Injection Control dialog box

• From the Tune Plus window, choose Setup > FT Injection Control, 
or

• click  in the Instrument Control toolbar.

The Injection Control dialog box has two pages to enable the 
independent selection of target values for ion trap scans and FT scans.

Ion Trap Page

Recommended target values for the ion trap:

Full MS Target: 3e+04
SIM Target: 1e+04
MSn Target: 5000
Zoom Target: 3000

Figure 2-13. Ion Trap page of the Injection Control dialog box
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FT Page

For FTMS measurements, only the Full MS target, the SIM target, and 
the MSn target are used.

Recommended target values for the FT analyzer:

Note Lower target values than those listed above may be used to obtain 
shorter inject times. For MSn scans, lower target values may also 
improve the isolation/fragmentation efficiency. Higher target values 
than those listed above can be used to improve the dynamic range. 
However, target values far above the recommended settings may affect 
isolation/fragmentation efficiency and mass accuracy for the 
FTMS analyzer. ▲

Enable Full Scan Injection Waveforms

You can enable or disable the injection waveforms for FT scans. For ion 
trap scans, the injection waveforms are always enabled.

If the injection waveforms are enabled, a filter is applied on the ions that 
are injected into the ion trap. The ions above and below the selected ion 
or ion range selected are rejected. This option is often useful if the ion 
trap is being filled with ions of greater or lesser mass than the ion mass 
or ion mass range of interest. For example, this option can be used to 
remove high mass ions that are not of interest and to ensure that more 
target ions can enter the trap before the trap is full. 

Full MS Target: 1e+06
SIM Target: 5e+04
MSn Target: 5e+04

Figure 2-14. FT page of the Injection Control dialog box
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Note The FT injection waveforms option only applies to full scan 
MS scans performed with the Orbitrap mass analyzer. In FT SIM and 
FT MSn scans, the injection waveforms are automatically enabled. ▲

FT Vacuum

Use the Vacuum dialog box to monitor the vacuum system parameters. 
The Vacuum dialog box has two pages to enable an independent 
selection of displaying the vacuum data of the ion trap or the FT part.

❖ To open the Vacuum dialog box

• From the Tune Plus window, choose Setup > Vacuum…, or

• click  in the Instrument Control toolbar.

Figure 2-15. Ion Trap page of the Vacuum dialog box

Figure 2-16. FT page of the Vacuum dialog box
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FT Temperature Monitor

Use the FT Temperature Monitor dialog box to view the status of the 
FTMS analyzer temperature regulation. Deviations of the actual 
temperature from the temperature setpoint can affect instrument 
performance. It is not possible to operate the instrument when the 
bakeout procedure is active.

❖ To open the FT Temperature Monitor dialog box

• From the Tune Plus window, choose Setup > FT Temperature 
Monitor…, or 

• click  in the Instrument Control toolbar.

FT Lock Masses

Choose Setup > FT Lock Masses to display the Lock Masses dialog 
box. See Figure 2-9 on page 2-11. Use this dialog box to enter and edit 
lock mass lists for positive and negative ion mode. See “Locking” on 
page 2-11 for details.

Figure 2-17. FT Temperature Monitor dialog box
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Tune Methods
Several parameters, like the ion source parameters, ion trap ion optics 
parameters, or AGC target values are stored in tune methods. This topic 
points out for which parameters a differentiation between ion trap and 
FTMS is made. The Tune Plus title bar displays the name of the current 
tune method. If you are not currently editing a preexisting tune method, 
the title bar displays the word Untitled. 

Parameters with Differentiation between Ion Trap Scans and FT Scans

A differentiation between ion trap scans and FTMS scans is made for 
the following tune parameters.

AGC Target Values

They can be set and saved independently for these experimental modes 
(no differentiation between positive and negative ion polarity mode):

• Ion Trap Full MS Target

• Ion Trap SIM Target

• Ion Trap MSn Target

• Ion Trap Zoom Target

• FT Full MS Target

• FT SIM Target

• FT MSn Target

Microscans and Maximum Inject Time

They can be set and saved independently for these experimental modes:

• Ion Trap Full MS, positive ion mode

• Ion Trap SIM, positive ion mode

• Ion Trap MSn, positive ion mode

• Ion Trap Zoom, positive ion mode

• FT Full MS, positive ion mode

• FT SIM, positive ion mode 

• FT MSn, positive ion mode 

• Ion Trap Full MS, negative ion mode
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• Ion Trap SIM, negative ion mode

• Ion Trap MSn, negative ion mode

• Ion Trap Zoom, negative ion mode

• FT Full MS, negative ion mode

• FT SIM, negative ion mode 

• FT MSn, negative ion mode 

Inject Waveform Flags

The flag whether the inject waveform is enabled or disabled can be set 
and saved independently for 

• Ion trap scans

• FT full scans.

Parameters without Differentiation between Ion Trap Scans and FT Scans

No differentiation between ion trap scans and FT scans is made for all 
ESI parameters, and for all ion source and ion optics parameters. 

Parameters not saved in a Tune Method

All parameters that can be set in an instrument method are not saved in 
the tune method. Thus, the following parameters are not saved in a tune 
method:

• Analyzer (Ion Trap or FTMS)

• Mass Range (Low, Normal, or High)

• Scan Rate 

• Resolution 

• Scan Type (Full, SIM, SRM, CRM)

• Scan Range

• Polarity* (positive or negative)

• Data type* (centroid or profile)

* Only the data format (centroid or profile) and the ion polarity are 
saved in a tune file that are set after a new start of Tune Plus.
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Chapter 3 Calibrating the Instrument for 
FTMS Measurements

This chapter provides procedures to calibrate the Orbitrap Elite mass 
spectrometer for FTMS measurements. It contains the following topics:

• “Preliminary Remarks” on page 3-2

• “Calibration Files and their Backups” on page 3-3

• “Calibration Solutions” on page 3-4

• “Calibration and Tuning of the Ion Trap” on page 3-11

• “Automatic Calibration Page” on page 3-15

• “Semi-Automatic Calibration Page” on page 3-17

• “Check Calibration Page” on page 3-19

• “FT Manual Calibration Page” on page 3-22
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Preliminary Remarks
There are no specific tune procedures for the FTMS part. All FTMS ion 
transfer and excitation parameters are treated as calibration parameters 
and are determined in automatic calibration procedures.

In the automatic calibration, the FT transmission calibration and the 
FTmass calibration are automatically performed for all calibration 
ranges. In the semi-automatic calibration, it is possible to decide 
whether the transmission and/or mass calibration are performed only for 
the positive ion mode, only for the negative ion mode or for both 
polarities. See “Automatic Calibration Page” on page 3-15 and 
“Semi-Automatic Calibration Page” on page 3-17 for further details.

On the FT Manual page of the Calibrate dialog box, you can select your 
own calibration masses for FT ion transmission, storage transmission, 
and FT mass calibration. See “FT Manual Calibration Page” on 
page 3-22 for further details. 

Note Thermo Fisher Scientific recommends using the semi-automatic 
calibration. ▲
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Calibration Files and their Backups
After a successful or partly successful calibration, the ion trap and 
FT calibration parameters are saved automatically. All ion trap and 
FT calibration parameters are stored in the calibration file 
master.LTQCal, which is located in the folder:

C:\Thermo\Instruments\LTQ\system\msx

The calibration parameters for the reagent ion source in Orbitrap 
Elite ETD mass spectrometers are stored in an additional calibration file 
master.LTQReagent, which is located in the same folder.

Backup Current Calibration

It is possible to create a backup of the current calibration file manually 
or by choosing File > Backup Current Calibration in the Tune Plus 
window. The Backup Current Calibration and Restore Backup 
Calibration commands work by copying the master.LTQCal to 
user.LTQCal and vice versa.

If a backup calibration user.LTQCal was already generated, the old 
user.LTQCal will be backed-up to a file named userXYZ.LTQCal. If 
you perform backup calibrations at regular intervals, then a history of 
your calibration files is generated in the folder:

C:\Thermo\Instruments\LTQ\system\msx

Using the Backup Calibration command regularly allows returning to 
previous calibrations in case a new calibration is suspected to have 
worsened instrument performance. 

Restore Backup Calibration

Upon Restore Backup Calibration, the calibration values saved in 
user.LTQCal are automatically downloaded to the instrument. 
Therefore, it is recommended to generate a current backup after a 
successful calibration. 

It is also recommended to use the Restore Backup Calibration 
command instead of the Restore Factory Calibration command 
because the backup calibration file is newer than the factory calibration 
file.

Note Pressing the reset button of the instrument loads the 
master.LTQCal file into the internal computer of the instrument. ▲
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Calibration Solutions
This section provides information about preparing the calibration 
solutions for the Orbitrap Elite mass spectrometer.

The positive ion mode calibration solution allows calibrating Thermo 
Scientific mass spectrometers with ESI or HESI II probe in positive ion 
mode. Supported instruments are the Orbitrap Elite mass spectrometer, 
the Thermo Scientific LTQ Velos Series mass spectrometers, and the 
Thermo Scientific LTQ Orbitrap Velos Series mass spectrometers. The 
positive ion mode calibration solution covers a mass range from m/z 74 
to m/z 1822 and is therefore usable for calibrations between m/z 50 and 
m/z 2000.

The negative ion mode calibration solution allows calibrating Thermo 
Scientific MS detectors with ESI source in negative ion mode. 
Supported instruments are the Orbitrap Elite, other LTQ based hybrid 
instruments (LTQ FT, LTQ FT Ultra, and LTQ Orbitrap series), and 
Exactive Series instruments. The negative ion mode calibration solution 
covers a mass range from m/z 265 to m/z 1880 and is therefore usable for 
calibrations between m/z 50 and m/z 2000.

Obtaining Ready-to-Use Calibration Solutions

To free you from time-consuming mixing and dilution steps and to 
allow you to focus on data acquisition, Thermo Fisher Scientific 
provides ready-to-use calibration solutions. Table 3-1 shows the 
available calibration solution packages.

You can order ready-to-use calibration solutions from 
www.thermo.com/pierce or www.fishersci.com. The prepared 
calibration solutions are shipped at ambient temperature and stable at 
2–8 °C for 1.5 years.

Table 3-1. Available calibration solutions packages

Calibration Solution Product Name Product Number

Positive ion mode Pierce LTQ Velos ESI Positive Ion 
Calibration Solution, 10 mL

88323

Negative ion mode Pierce ESI Negative Ion Calibration 
Solution, 10 mL

88324

http://www.thermo.com/pierce
http://www.fishersci.com
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Chemicals for Preparing Calibration Solutions

The n-butylamine, caffeine, MRFA, Ultramark 1621, sodium dodecyl 
sulfate, and sodium taurocholate needed to make the calibration 
solutions are supplied with your chemical accessory kit. When ordering 
replacements, use the information listed in Table 3-2.

To order more of these compounds, contact:

Sigma Chemical Company
P. O. Box 14508
St. Louis, Missouri, USA 63178-9916
Phone (800) 325-3010 (in the U.S. & Canada)

(314) 771-3750 (U.K. & International)
Web site www.sigma-aldrich.com

or

ABCR GmbH & Co. KG
Im Schlehert 10
D-76187 Karlsruhe, Germany
Phone +49 (0)721 950 61-0
Fax +49 (0)721 950 61-80
Email info@abcr.de
Web site www.abcr.de/english.htm

Solvents and Modifiers

You can also order specific chemicals from Thermo Fisher Scientific, 
which are sold under its Fisher Chemical brand. As specified in 
Table 3-3 use only LCMS grade chemicals for calibrating your 
LTQ Orbitrap Series system.

Table 3-2. Calibration compounds for Orbitrap Elite MS

Description Quantity Supplier Product Number

Supplier: Sigma Chemical Company, see below.

n-Butylamine*

*If ordering elsewhere, use only mass spec grade quality.

25 mL 471305-25ML

Caffeine Methanol Solution 1 mL C6035-1ML

Met-Arg-Phe-Ala acetate salt 5 mg M1170-5MG

Sodium Dodecyl Sulfate 10 g L4509-10G

Sodium Taurocholate Hydrate 250 mg T4009-250MG

Supplier: ABCR GmbH & Co. KG, see below.

Ultramark® 1621 Mass Spec. Standard 250 mg AB172435

http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.abcr.de/english.htm
http://www.abcr.de/english.htm
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For a complete selection of LCMS-grade consumables from Fisher 
Scientific, visit www.FisherLCMS.com.

Safety Advice

Potentially hazardous chemicals used in procedures throughout this 
chapter include the following:

• Glacial acetic acid

• Acetonitrile

• Methanol

• Formic acid

Note Store and handle all chemicals in accordance with standard safety 
procedures. The Material Safety Data Sheets (MSDS) describing the 
chemicals being used are to be freely available to lab personnel for them 
to examine at any time. Material Safety Data Sheets (MSDS) provide 
summarized information on the hazard and toxicity of specific chemical 
compounds. The MSDS also provides information on the proper 
handling of compounds, first aid for accidental exposure, and 
procedures for the remedy of spills or leaks. Producers and suppliers of 
chemical compounds are required by law to provide their customers 
with the most current health and safety information in the form of an 
MSDS. Read the material safety data sheets for each chemical you use. ▲

Caution Please consider the following cautions when preparing 
calibration solutions:

• Do not filter solvents. Filtering solvents can introduce 
contamination.

• Do not use plastic pipettes to prepare your tuning and calibration 
standards. Plastic products can release phthalates that can interfere 
with your analyses. ▲

Table 3-3. Recommended solvents and reagents

Solvent / Reagent Specifications Fisher Chemical P/N

Methanol LCMS grade A456-4

Acetonitrile LCMS grade A955-4

Water LCMS grade W6-4

Isopropyl alcohol LCMS grade A461-4

Acetic acid (modifier) LCMS grade A507-500 or A35-500

Formic acid (modifier) 99–100% (This acid must be 
supplied in a glass bottle.)

A117-50

http://www.FisherLCMS.com
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Preparing Stock Solutions

Use the chemicals described in the previous section to prepare the 
calibration solutions from the following stock solutions:

• ”Caffeine Stock Solution”, next topic

• “MRFA Stock Solution” on page 3-7

• “Ultramark 1621 stock solution” on page 3-8

• “N-Butylamine Stock Solution” on page 3-8

• “Sodium Dodecyl Sulfate Stock Solution” on page 3-8

• “Sodium Taurocholate Stock Solution” on page 3-8

Caffeine Stock Solution

A 1 mg/mL stock solution of caffeine in 100% methanol is provided 
with your LTQ Orbitrap Series MS detector. You can also order this 
solution through Sigma. The Sigma product number for this solution is 
C6035.

MRFA Stock Solution

❖ To prepare the MRFA stock solution

1. Obtain the vial of L-methionyl-arginyl-phenylalanyl-alanine 
acetate × H2O (MRFA) in your accessory kit. In this form, the 
MRFA sample has an average molecular weight of 523.7 u. 
Carefully weigh 3.0 mg of the MRFA sample.

2. Dissolve the MRFA sample in a total volume of 1.0 mL of 50:50 
methanol:water. Mix the solution (5.0 nmol/μL) thoroughly.

3. Transfer 50 μL of the 5 nmol/μL solution into a clean polypropylene 
tube.

4. Add 1.45 mL of 50:50 methanol:water to the tube. Mix this 
solution (166.7 pmol/μL) thoroughly.

5. Label the tube MRFA stock solution and store it in a freezer until it is 
needed.

Warning Avoid exposure to potentially harmful materials.
Always wear protective gloves and safety glasses when you handle 
solvents or corrosives. Also contain waste streams and use proper 
ventilation. Refer to your supplier's Material Safety Data Sheet (MSDS) 
for proper handling of a particular solvent. ▲
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Ultramark 1621 stock solution

❖ To prepare the Ultramark 1621 stock solution

1. Obtain the vial of Ultramark 1621 in your accessory kit.

2. Using a syringe, measure out 10 μL of Ultramark 1621, and dissolve 
it in 10 mL of acetonitrile. 

3. Mix the solution thoroughly.

4. Label the vial Ultramark 1621 stock solution and store it in a freezer 
until it is needed.

N-Butylamine Stock Solution

❖ To prepare the n-butylamine stock solution

1. Using a syringe, transfer 5 μL of n-butylamine to a 25 mL 
(minimum) volumetric glass flask.

2. Add 9995 μL of 50:50 methanol/water to the flask.

3. Mix the solution thoroughly.

4. Transfer the solution to a vial.

5. Label the vial N-butylamine stock solution.

Sodium Dodecyl Sulfate Stock Solution

❖ To prepare the sodium dodecyl sulfate stock solution

1. Obtain the vial of sodium dodecyl sulfate. In this form, the sample 
has an average molecular weight of 288.4 u. 

2. Prepare the stock solution of sodium dodecyl sulfate by dissolving 
2.88 mg in 10 mL of 50:50 methanol:water.

3. Mix the solution (1.0 nmol/μL) thoroughly. 

4. Label the vial Sodium Dodecyl Sulfate stock solution (1 nmol/μL).

Sodium Taurocholate Stock Solution

❖ To prepare the sodium taurocholate stock solution

1. Obtain the vial of sodium taurocholate. In this form, the sample has 
an average molecular weight of 537.7 u.

2. Prepare the stock solution of sodium taurocholate by dissolving 
5.38 mg in 10 mL of 50:50 methanol:water.
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3. Mix the solution (1.0 nmol/μL) thoroughly.

4. Label the vial Sodium Taurocholate stock solution (1 nmol/μL).

LTQ/FT-Hybrid Positive Ion Mode Calibration Solution

The LTQ/FT-hybrid positive ion mode calibration solution consists of 
caffeine, MRFA, Ultramark 1621, and n-butylamine in an 
acetonitrile:methanol:water solution containing 1% acetic acid.

❖ To prepare the positive ion mode calibration solution

1. Pipet 20 μL of the caffeine stock solution into a light-protected, 
clean, dry 10 mL volumetric flask.

2. Pipet 100 μL of the MRFA stock solution into the flask.

3. Pipet 100 μL of the Ultramark 1621 stock solution into the flask.

4. Pipet 100 μL of the stock solution of n-butylamine into the flask.

Caution Use only glass pipets or stainless steel syringes when measuring 
glacial acetic acid. Using plastic pipet tips causes contamination of acid 
stock solutions that can introduce contaminants in the calibration 
solution. ▲

5. Pipet 100 μL of glacial acetic acid into the flask. 

6. Pipet 5 mL of acetonitrile into the flask.

7. Bring the volume of the solution up to the 10 mL-mark on the flask 
with 50:50 methanol:water.

8. Mix the calibration solution thoroughly.

9. Transfer the solution to a light-protected, clean, dry vial.

10. Label the vial Positive Ion Mode Calibration Solution and store it in a 
freezer until it is needed.

LTQ/FT-Hybrid Negative Ion Mode Calibration Solution

The LTQ/FT-hybrid negative ion mode calibration solution consists of 
sodium dodecyl sulfate, sodium taurocholate, and Ultramark 1621 in an 
acetonitrile:methanol:water solution containing 1% acetic acid.

❖ To prepare the negative ion mode calibration solution

1. Pipet 100 μL of the sodium dodecyl sulfate stock solution into a 
light-protected, clean, dry 10 mL volumetric flask.
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2. Pipet 100 μL of the sodium taurocholate stock solution into the 
flask.

3. Pipet 100 μL of the Ultramark 1621 stock solution into the flask.

Caution Use only glass pipets or stainless steel syringes when measuring 
glacial acetic acid. Using plastic pipet tips causes contamination of acid 
stock solutions that can introduce contaminants in the calibration 
solution. ▲

4. Pipet 100 μL of glacial acetic acid into the flask. 

5. Pipet 5 mL of acetonitrile into the flask.

6. Bring the volume of the solution up to the 10 mL-mark on the flask 
with 50:50 methanol:water.

7. Mix the solution thoroughly.

8. Transfer the solution to a light-protected, clean, dry vial.

9. Label the vial Negative Ion Mode Calibration Solution and store it in 
a freezer until it is needed.

Applicable Calibration Solutions for FT Manual Calibration

Because the FT Manual page of the Calibrate dialog box allows using 
your own calibration masses, it is possible to use custom calibration 
solution here. However, there are some requirements for the calibration 
masses. The scan ranges of the instrument need to be covered properly 
by the given masses.
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Calibration and Tuning of the Ion Trap
This chapter describes the calibration and tuning of the ion trap for 
FTmeasurements.

Calibration of the Ion Trap

The ion trap has to be successfully calibrated before an FT calibration is 
performed. It is very important that the electron multiplier gain is 
correctly calibrated because the AGC prescan is performed in the ion 
trap. Thus, the electron multiplier gain calibration should be checked 
before an FT calibration is performed.

For the ion trap calibrations, the positive ion mode calibration solution 
or the negative ion mode calibration solution can be used.

Tuning the Ion Trap for Positive Ion Mode

For the positive ion mode, it is recommended to perform an automatic 
tune of m/z 524 at a Full MS Target of 1e4–3e4. Use the positive ion 
mode calibration solution or the negative ion mode calibration solution 
with the settings in the Define Scan dialog box that are shown on 
Figure 3-1 on page 3-12.

The spectrum should look similar to the spectrum shown in Figure 3-2 
on page 3-12 and Figure 3-3 on page 3-13. Make sure the peaks at 
m/z 74, 138, 195, 524, and the highest Ultramark peaks are all present, 
ideally above 30% of the base peak.

The inject time should be stable and less than 150 μs (if a Full MS target 
of 3e4 is used). Do not forget to save the tune method after a successful 
tuning.
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Figure 3-1. Recommended settings in the Define Scan dialog box for an automatic tune of the ion trap

Figure 3-2. Ion trap spectrum of positive ion mode calibration solution, scan range m/z 130–2000, positive ion 
polarity mode

* Label for m/z 138.00 added manually

*
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Tuning the Ion Trap for Negative Ion Mode

For the negative ion mode, it is recommended to perform an automatic 
tune of m/z 514 at a Full MS Target of 1e4–3e4. Use the negative ion 
mode calibration solution with the settings shown in Figure 3-1 on 
page 3-12.

After the automatic tuning, a manual adjustment of the S-lens RF level 
should be used to get an ion trap spectrum in the scan range 
m/z 150–2000. At m/z 265 is the base peak (100%) and the highest 
Ultramark adduct ion peaks are at about 80%, as shown in Figure 3-4 
on page 3-14. 

The S-lens RF level affects the mass spectrum as follows:

• Decreasing the S-lens RF level will decrease the amount of 
fragmentation of fragile ions in the S-lens. 
Decreasing the S-lens RF level will decrease the transmission of high 
m/z ions through the S-lens and increase the transmission of the low 
m/z ions. 

Figure 3-3. Ion trap spectrum of the positive ion mode calibration solution (lower range), positive ion polarity mode

n-Butylamine peak

Caffeine fragment peak
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• Increasing the S-lens RF level will increase the amount of 
fragmentation of fragile ions in the S-lens. 
Increasing the S-lens RF level will increase the transmission of high 
m/z ions through the S-lens and decrease the transmission of the low 
m/z ions. 

If the S-lens RF level is set very low, in-source fragmentation of the 
Ultramark adduct ions may occur. Thus, if you observe rather ions at 
m/z 906, 1006, … than ions at m/z 1280, 1380, … the S-lens RF level 
has to be increased. The inject time should be stable and less than 1 ms 
(if a target of 1e4 is used). Do not forget to save the tune method after a 
successful tuning.

Figure 3-4. Ion trap spectrum of the negative ion mode calibration solution, scan range m/z 150–2000, negative ion 
polarity mode
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Automatic Calibration Page
Use the Automatic page of the Calibrate dialog box to perform an 
automatic calibration of all the calibration parameters, including all ion 
trap calibrations and all FT calibrations. See Figure 3-5.

In an automatic calibration, the FT calibration procedures are 
performed automatically one after another, following the ion trap 
calibration. To perform an automatic calibration, the negative ion mode 
calibration solution has to be used.

The calibration masses and all experimental parameters (for example, 
target values, scan ranges, or resolution settings) are set automatically 
and cannot be influenced by the user. 

Figure 3-5. Automatic page of the Calibrate dialog box
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Note Usually, you do not need to perform a complete ion trap 
calibration or an FT ion transmission calibration unless the hardware is 
modified in some way. However, it is necessary to repeat the electron 
multiplier calibration and the FT mass calibration on a regular basis. 
Thus, in the most cases it is not recommended to perform an automatic 
calibration of the Orbitrap Elite mass spectrometer. In this case, all 
calibrations are performed, which takes about 1 hour. To run a 
multiplier gain calibration or an FTmass calibration (which takes only 
some minutes), it is recommended to use the semiautomatic 
calibration. ▲
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Semi-Automatic Calibration Page
Use the Semi-Automatic page of the Calibrate dialog box to select 
specific calibration parameters to calibrate, for example only the ion trap 
calibrations or only the FT calibrations. (See Figure 3-6.) For 
FT calibrations, it is also possible to differentiate between positive and 
negative ion mode.

To calibrate one or more selected parameters, clear the Select All check 
box to make the individual calibration parameters available. Select the 
parameter(s) you want to calibrate, then click Start.

For example:

• To run a complete automatic calibration (ion trap and FT), select 
the Select All check box. Then, click Start. This is analogous to the 
automatic calibration. As already described before, it is not 
recommended to perform an automatic calibration of the Orbitrap 
Elite mass spectrometer if not necessary because all calibrations are 
performed, which takes about 1 hour.

Figure 3-6. Semi-Automatic page of the Calibrate dialog box
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• To run an automatic calibration of the ion trap, select the Select 
All—Ion Trap check box. Then, click Start.

• To run an automatic calibration of the FT part, select the Select 
All—FT check box. Then, click Start.

• To run an FT mass calibration, select the Mass Calibration check 
box. Then, click Start.

In a semi-automatic calibration, the selected FT calibration procedure(s) 
are performed automatically one after another. 

All calibrations apart from the FT calibrations for the negative ion mode 
can be performed with either the positive ion mode calibration solution 
or the negative ion mode calibration solution. To run the FT ion 
transmission and/or the mass calibration for the negative ion mode, the 
negative ion mode calibration solution has to be used. 

The calibration masses and all experimental parameters like target 
values, scan ranges, resolution settings, inject waveforms etc. are set 
automatically and cannot be influenced by the user.

HCD Transmission

Use this check box to specify whether to perform a calibration of the 
higher energy collision-induced dissociation (HCD) transmission 
efficiency of the Orbitrap mass analyzer in positive ion mode. 
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Check Calibration Page
Use the Check page of the Calibrate dialog box to automatically check 
several calibration settings. See Figure 3-7.

All calibration checks apart from those for the FT negative ion mode 
can be performed with either the negative ion mode calibration solution 
or the positive ion mode calibration solution. To check the 
FT calibrations in the negative ion mode, the negative ion mode 
calibration solution has to be used.

The calibration masses and all experimental parameters like target 
values, scan ranges, resolution settings, etc. are set automatically.

At the conclusion of the check procedure, the Orbitrap Elite mass 
spectrometer displays a message that indicates whether the parameter(s) 
are calibrated properly or not.

Figure 3-7. Check page of the Calibrate dialog box
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Using the Check page of the Calibrate dialog box, you can select the 
following parameters:1

1This feature is available only in the Orbitrap Elite ETD mass spectrometer.

Select All Use this check box to specify whether or not to 
check all calibration parameters. To check all 
calibration parameters, select the Select All 
check box. In this case, all ion trap calibration 
parameters and all FT calibration parameters 
are checked. You can also check each 
calibration parameter individually. To make 
the individual calibration parameters available, 
clear the Select All check box.

Select All Ion Trap Use this check box to specify whether or not to 
check the calibration of only the ion trap 
parameters.

Reagent Ion Selection1 Use this check box to specify whether or not to 
check the reagent ion source selection.

Select All-FT Use this check box to specify whether or not to 
check the calibration of only the FT ion 
transfer optics and mass analyzer.

Reagent Ion Source 
Transfer Multipole RF 
Frequency1

Use this check box to specify whether or not to 
check the frequency of the RF voltage of the 
transfer multipole in the reagent ion source 
optics.

Transfer Multipole RF 
Frequency

Use this check box to specify whether or not to 
check the frequency of the RF voltage of the 
transfer multipole in the FT transfer ion 
optics.

Storage Multipole RF 
Frequency

Use this check box to specify whether or not to 
check the frequency of the RF voltage of the 
storage multipole in the FT transfer ion optics. 

Positive Ion Mode Use this check box to specify whether or not to 
check the FT ion transmission calibration and 
FT mass calibration for the positive ion mode.

Negative Ion Mode Use this check box to specify whether or not to 
check the FT ion transmission calibration and 
FT mass calibration for the negative ion mode.
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The Last Check Date readback column gives the date of the last 
successful check for each item. If a check is performed that fails, the last 
successful check date still appears in the Last Check Date readback 
column. The last successful check continues to be in effect in the 
instrument. However, the result column will show a red x mark 
indicating that the current attempt check has failed or was aborted.

Storage Transmission Use this check box to specify whether or not to 
check the ion storage transmission calibration. 
The storage transmission is checked by 
transferring ions form the ion trap to the ion 
storage device and back, then scanning in the 
ion trap. The FT storage transmission 
calibration can be checked for the positive and 
negative ion mode independently.

FT Transmission Use this check box to specify whether or not to 
check the FT ion transmission calibration. The 
ion transmission from the ion trap to the 
Orbitrap analyzer is checked by means of the 
calibration masses in SIM experiments at 
different AGC target values. The 
FT transmission calibration can be checked for 
the positive and negative ion mode 
independently.

Mass Calibration Use this check box to specify whether or not to 
check the mass calibration of the Orbitrap 
mass analyzer. By doing so, the current mass 
calibration is checked, that is a check of the 
external mass calibration. The FTmass 
calibration can be checked for the positive and 
negative ion mode independently.

Enhanced FT Use this check box to specify whether or not to 
check the Enhanced FT calibration of the 
Orbitrap mass analyzer. The Enhanced 
FT calibration can be checked for the positive 
and negative ion mode independently.

HCD Transmission Use this check box to specify whether or not to 
check the HCD transmission calibration. To 
check the HCD transmission calibration, first 
make this check box available by clearing the 
Select All check box. Then, select the HCD 
Transmission check box.
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FT Manual Calibration Page
Use the FT Manual page of the Calibrate dialog box to perform or check 
an FT mass calibration with user-defined calibration masses. See 
Figure 3-8.

All experimental parameters like target values, scan ranges, resolution 
settings, etc. must be set manually.

Note When starting from the FT Manual page, the calibration is 
performed for the currently selected polarity only. ▲

Figure 3-8. FT Manual page of the Calibrate dialog box
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Mass List Area

The calibration masses for manual calibration can be defined in the 
corresponding mass list on the FT Manual page of the Calibrate dialog 
box. Mass lists can be imported and exported via the Instrument 
Configuration page. See further details in Chapter 6: “Instrument 
Configuration”.

Note Ensure that you have calculated the calibration masses with 
sufficient accuracy (sub ppm). ▲

Factory-Supplied Mass Lists

There are also two factory supplied mass lists, calmix_positive (factory) 
and calmix_negative (factory). They contain the exact masses of all main 
ion peaks, which should appear if the negative ion mode calibration 
solution is used in positive or negative ion mode, respectively. 

Name This list box lists the names of the factory supplied and user 
created mass lists. 

Mass List This table lists the mass-to-charge ratios of the ions that 
you are using to calibrate the Orbitrap mass analyzer. You 
can select an existing mass list in the Name list box, or you 
can create or modify a mass list by clicking on it and editing 
the entries in the Mass List table. 

Save Click Save to save the mass list with the name that is 
selected in the Name list box.

Save As Click Save As a to save the mass list with a new name.

Delete Click Delete to delete the mass list that is selected in the 
Name list box.
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Chapter 4 Performing Diagnostics/Checks

This chapter describes several diagnostic procedures for the Orbitrap 
Elite mass spectrometer. It contains the following topics:

• “System Evaluation Procedures” on page 4-2

• “Toggles” on page 4-8

• “Set Device” on page 4-12

• “Display Settings” on page 4-15
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System Evaluation Procedures
Use the System evaluation page in the Diagnostics dialog box to evaluate 
the system performance. See Figure 4-1.

❖ To display the System evaluation page

From the Tune Plus window, choose Diagnostics > Diagnostics > 
Tools > System evaluation.

In addition to several ion trap relevant system evaluation procedures, 
you can perform various FT system evaluation procedures, which are 
described in the following topics.

FT CLT-RF Pulser Evaluation

This procedure1 determines the pulser timing characteristics of the 
CLT RF board. This procedure requires the infusion of the calibration 
solution in positive ion polarity mode.

Figure 4-1. System evaluation page of the Diagnostics dialog box (Orbitrap Elite MS)

1This feature is available only in the Orbitrap Elite ETD mass spectrometer.
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FT Dynamic Range Test

This test is only applicable for an infusion experiment with a solution 
containing MRFA, for example the positive ion mode calibration 
solution or a MRFA alone solution (for example 5×10-6 M in 
100% methanol/water, 1% acetic acid). This test determines the 
signal-to-noise ratio of an isolated MRFA signal.

FT Energy Dependence Evaluation

This procedure determines the change in mass calibration when varying 
the ion energy (HV Offset). This procedure can help evaluating the 
FTMS analyzer components.

FT ETD Fragmentation Efficiency

This procedure1 determines the ETD fragmentation efficiency, which is 
the percentage of ions that fragment relative to the parent ions. The test 
can run in both ion trap modes and FTMS modes. To run the test, you 
must infuse a solution of Angiotensin I to generate a spectrum that 
shows a triply-charged Angiotensin I ion at m/z 433 with an intensity of 
greater than 5E+5. 

FT HCD Collision Cell Ejection Evaluation

This procedure analyzes the dynamics of ions in the HCD collision cell. 
This procedure can help evaluating the HCD collision cell components.

FT HCD Multipole Evaluation

This procedure evaluates the linearity and maximum amplitude of the 
HCD multipole.

FT High Mass Range Target Compensation

This procedure determines an AGC target compensation factor, which 
ensures that the FT mass calibration is still valid if the instrument is set 
into the high mass range mode. The resulting compensation factor will 
be saved in the calibration file. Usually, it is sufficient to run this 
procedure once. It is not necessary to repeat this procedure on a regular 
basis. It is recommended to use the positive ion mode calibration 
solution for this test. However, you can also use any other solution that 
gives reasonable ion signals at 1000 < m/z < 2000.

1This feature is available only in the Orbitrap Elite ETD mass spectrometer.
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FT Isolation Test

This test is only applicable for an infusion experiment with a solution 
containing MRFA, for example the positive ion mode calibration 
solution or a MRFA alone solution (for example 5×10-6 M in 100% 
methanol/water, 1% acetic acid). This test is analogous to the “Check of 
the ion isolation waveform” on the Check page of the Calibrate dialog 
box. Here, the isolation of m/z 525.3 is performed at an AGC target of 
2e+03 and analyzed by the ion trap. In contrast to this, the FT isolation 
test is performed at higher targets and uses the FT analyzer. Thus this 
test determines the maximum AGC target value that allows performing 
a unit isolation of m/z 525.3 at the presence of m/z 524.3 and 526.3.

FT Noise Test

This test determines resistant noise peaks in the selected scan range. In 
this test, ion generation is switched off automatically. At the conclusion 
of the FT noise test, a list of resistant noise peaks is displayed in the 
Testing text.

FT Preamp Evaluation

Use this evaluation to check the basic FTMS analyzer signal detection 
path. The instrument needs to run in FTMS analyzer mode. Thermo 
Fisher Scientific recommends switching to diagnostic transient view. See 
“FT Include Transient” on page 4-9.

During the evaluation, the preamplifier input protection switches are 
activated with a period of 100 ms. This switching can be observed as 
periodic incidences in the transient if the electronic signal path is 
operational. 

FT Pulser Evaluation

This procedure tests characteristics of the high voltage pulser. This 
procedure can help evaluating the FTMS analyzer electronics.

FT Reagent Ion Source Drift Time Evaluation

This evaluation1 determines the drift time of reagent ions from the 
reagent ion source to the linear trap mass analyzer. This procedure 
requires the reagent ion source and filament to be switched on.

1This feature is available only in the Orbitrap Elite ETD mass spectrometer.
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FT Reagent Ion Source Transfer Multipole Evaluation

This procedure1 evaluates the linearity and maximum amplitude of the 
reagent ion transfer multipole.

FT Sensitivity Test

The FT sensitivity test is only applicable for an infusion experiment 
with reserpine. The test assumes that a reserpine solution of 5×10-9 M 
(100% methanol, 1% acetic acid) is used. The following test are 
performed one after another:

1. SIM of m/z 609.3 using the ion trap as analyzer and an AGC target 
of 2e+03. 

2. SIM of m/z 609.3 using the Orbitrap detector as analyzer and an 
AGC target of 5e+03.

3. SIM of m/z 609.3 using the Orbitrap detector as analyzer and an 
AGC target of 5e+04.

4. MS/MS of m/z 609.3 using the Orbitrap detector and an 
AGC target of 5e+04.

The test fails

• if the inject time, which is necessary to reach the selected 
AGC target value, is too high; 

• if the ratio of the reserpine signal to the overall signal inside the 
SIM window is too low; 

• if the ion transmission from the ion trap to the Orbitrap detector is 
too low, or 

• if the intensity of the product ions of reserpine is too low.

FT Stability Test

This test is applicable for an infusion experiment with any sample 
solution. This test procedure checks the stability of the FT TIC (total 
ion current) detected in the selected scan range by means of 600 scans. 
In principle, the test can be performed at any experimental conditions. 
It is recommended, however, to perform this test in Full scan mode 
using one microscan, a resolution setting of 60000 and a FT Full MS 
Target of 5e+05 or 1e+06. At the conclusion of the FT stability test, the 
AGC stability and the corresponding signal variation is displayed. See 
Figure 4-2.

1This feature is available only in the Orbitrap Elite ETD mass spectrometer.
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FT Temperature Control Evaluation

Use this evaluation procedure to examine the temperature regulation 
behavior of the instrument by intentionally driving temperatures to 
extreme values. 

Note The evaluation will usually take more than 12 hours where no 
measurements can be done. After stopping the evaluation, the 
instrument needs to stabilize temperatures for several hours before high 
mass accuracy measurements can be started. ▲ 

FT Temperature Monitor

Mass accuracy of the Orbitrap detector with external mass calibration 
depends on a stable temperature of the analyzer and the electronic 
components. This evaluation plots a history of the temperature 
regulation results to the Graph view. See “Graph View” on page 2-5.

Figure 4-2. Result of the FT stability test displayed in the Graph View
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Reagent CI Gas Pressure Evaluation

This evaluation procedure1 plots the CI gas pressure of the reagent ion 
source against the anion intensity; the instrument then calculates the 
optimum reagent gas pressure. Enter this value into the CI Gas Pressure 
spin box of the Reagent Ion Source dialog box. See Figure 7-5 on 
page 7-6.

Note Thermo Fisher Scientific recommends performing this procedure 
after replacing the filament and/or the ion volume. ▲

1This feature is available only in the Orbitrap Elite ETD mass spectrometer.
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Toggles
Use the Toggles page in the Diagnostics dialog box to switch a 
subsystem from one state to another state. See Figure 4-3.

❖ To display the Toggles page

From the Tune Plus window, choose Diagnostics > Diagnostics > 
Tools > Toggles.

Caution All toggles should only be used for diagnostic purposes. The 
functionality of the Orbitrap Elite mass spectrometer may be harmed if 
a toggle is switched to a status that differs from its default value. ▲

If one of the FT toggles is (accidentally) different from its default value 
during data acquisition, the FT Analyzer Settings of the Scan Header of 
a raw file contains a reference to this. See Appendix A: “Miscellaneous 
Information” for further details.

Note The status of a toggle is not saved in the tune method and is set 
back to its default value after an instrument reset. The toggle state 
shown by the radio buttons next to the list box does not necessarily 
correspond to the actual settings. ▲

Figure 4-3. Toggles page of the Diagnostics dialog box



Performing Diagnostics/Checks
Toggles

Thermo Fisher Scientific Orbitrap Elite Getting Started (P/N 1288180, Revision A) 4-9

Enhanced FT

With this toggle, the Advanced Signal Processing is switched on. The 
default setting is On (enabled).

FT Advanced Calibration

With this toggle, the Advanced Calibration Features are switched on. 
The default setting is Off (disabled).

FT Analyzer Ion Gauge

With this toggle, the ion gauge for the FT analyzer vacuum can be 
disabled manually for diagnostic purposes. The default setting is On 
(enabled).

FT Analyzer Temperature Control 

With this toggle, the FT analyzer temperature control regulation 
electronics can be disabled for diagnostic purposes. The default setting is 
On (enabled). 

FT Apodization

With this toggle, the apodization can be switched on or off. The default 
setting is On.

FT Include Transient

If this toggle is on, it is possible to display transients in the Spectrum 
view by choosing Show FT Transient in the shortcut menu of the 
Spectrum view. The menu is displayed when you right-click anywhere 
on that page. See “Spectrum View” on page 2-3 for further details. 

Note A transient view is only possible if profile (instead of centroid) is 
chosen as data format. ▲

During transient display in Spectrum view, the x-coordinate is 
misleadingly labeled with m/z instead of milliseconds. The default 
setting is Off.

Note It is not possible to acquire transients into an Xcalibur raw file. ▲
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FT Manual Calibration for Single Range

This toggle can be used to influence the behavior of the FT manual 
calibration procedures. See “FT Manual Calibration Page” on 
page 3-22. In the default behavior, the FT manual calibration 
procedures calibrate the whole scan mass range for the actual polarity.

To be able to use non-standard calibration substances that cover a 
limited mass range only, advanced users may enable this toggle. With 
this toggle enabled, there is no check for mass range coverage of 
reference mass lists. Instead, the instrument stays in the chosen mass 
range and calibrates this range only. With this toggle enabled, the user is 
responsible to cover the whole mass range needed, possibly by 
calibrating manually in several steps with different substances. If the 
performed FT manual calibration is not suitable for the scan settings 
used in an FTMS analyzer data acquisition, the scan header of a raw 
data file contains a reference to this. See Chapter A: “Miscellaneous 
Information” for further details.

FT Profile Mode

Use this toggle to select whether the FT profile mode corresponds to a 
Full Profile format or to a Reduced Profile format. It is recommended to 
use the Reduced Profile Mode for data acquisition because the data size 
of the raw file is significantly decreased by using the Reduced Profile. 
The default setting is Reduced. For further information, see also “Data 
Size of FT Raw Files” on page A-4. 

FT SIM and MSn Injection Waveforms

Usually, for FT SIM scans and FT MSn scans the injection waveforms 
are automatically enabled. It is not possible to change this setting in the 
Injection Control dialog box. With this toggle, it is possible to disable or 
enable the injection waveforms manually for diagnostic purposes. The 
default setting is On. 

FT Storage Evaluation Mode

This toggle can be used to test the characteristics of ion transfer 
components for the FTMS analyzer. The default setting is On 
(enabled).
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FT View Frequency

If this toggle is switched on, the FT spectrum is shown as a frequency 
spectrum. If the system is on and the FT is chosen as analyzer, the 
frequency spectrum is displayed in the Spectrum view. The default 
setting is Off.

Note The x-coordinate is misleadingly labeled with m/z instead of 
kHz. ▲

This toggle is for diagnostic purposes only. Therefore, it is not possible 
to acquire frequency spectra.

FT Zero Offset

If this toggle is switched on, an offset is added to the spectrum. This 
enables to view the full noise band. The default setting is Off, if the 
Reduced Profile format is used. The setting is On, if the Full Profile 
format is used.

Isolate Reagent Ion

Use this toggle1 to enable manually adjusting of the Back Multipole 
DC Offset voltage. See “Tuning the Quadrupole Mass Filter” on 
page 7-21. The default setting is Off.

Reagent Ion AGC

If this toggle1 is switched on, the instrument automatically performs an 
AGC scan of the reagent ion source in regular intervals. The default 
setting is Off.

1This feature is available only in the Orbitrap Elite ETD mass spectrometer.
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Set Device
Use the Set device page of the Diagnostics dialog box to select devices or 
experimental parameters from the list and to set the value for that device 
or parameter. See Figure 4-4. 

❖ To set a device

1. Select the device or parameter you would like to set from the Device 
list box.

2. Enter the device parameter's value in the text box below the Device 
list box.

3. Click Set to apply the change to the device value or parameter.

Note The value in the text box below the Device list box, which is 
displayed after the call of this page, does not necessarily correspond to 
the actual value. ▲

The following topics describe several FT relevant parameters that may 
be changed from this page.

Figure 4-4. Set device page of the Diagnostics dialog box
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Note After an instrument reset, the manual settings are overwritten with 
the corresponding calibration parameters. ▲

Caution Changing the instrument settings can harm the functionality of 
the Orbitrap Elite mass spectrometer, especially if followed by saving the 
calibration parameters (manually or at conclusion of a calibration 
procedure). Thus, this option should only be used by very advanced 
users. ▲

FT HCD Gradient 1 / FT HCD Gradient 2

Use this device to change the voltage gradients along the length of the 
HCD collision cell.

FT HCD Offset

Use this device to change the offset voltage of the HCD collision cell.

FT Lockmass Abundance

Use this device to change the target value of an injected lock mass 
relative to the actual FT scan target value. The default is 10%. The 
recommend target value is 0%, which means that injection of lock 
masses is turned off completely. Also see “Locking” on page 2-11.

FT Mass Check Test Duration

Use this device to change the duration of FT Manual mass calibration 
checks. See “FT Manual Calibration Page” on page 3-22. By changing 
this value, a long-term mass stability evaluation can be run. The default 
procedure of the FT manual mass calibration check is to perform 
100 scans checking the mass accuracy. The test duration may be 
extended to up to 72 hours. The default procedure can be restored by 
setting the duration to zero. If the duration is set between two and 
24 hours, the FT manual mass calibration check will specially control 
the syringe pump to allow running long-term test with a single syringe 
filling. For durations above 24 hours, it is assumed that an external 
syringe pump is used.

Setting new FT Transfer Optics Parameters

Two set device items can be used to overwrite the FT optics values:

• FT Optics Device Address
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• FT Optics Set Value

These values are originally determined during instrument calibration 
and set automatically. Overwriting calibration values will influence 
instrument performance and should only be done for diagnostic 
purposes. 

Note If you have changed FT transfer optics settings, Thermo Fisher 
Scientific recommends performing a full FT instrument calibration 
afterwards to assure good instrument performance. ▲
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Display Settings
Use the Display Settings page in the Diagnostics dialog box to select a 
variety of instrument settings for display. See Figure 4-5. Select the 
instrument settings you want to display and click Start. The Orbitrap 
Elite mass spectrometer displays the requested instrument settings in the 
Testing text box.

The following FT relevant instrument settings can be displayed:

Figure 4-5. Display settings page of the Diagnostics dialog box

Display FT calibration settings Displays all FT relevant calibration 
parameters in the diagnostics text 
box.

Display FT diagnostics Displays current diagnostic 
readback values of the FT electronic 
boards.

Display FT instrument settings Displays the current values of those 
FT instrument settings that depend 
on the scan range and ion polarity 
mode and can be changed manually 
on the Set Device page of the 
Diagnostics dialog box.
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In the Orbitrap Elite ETD mass spectrometer, an additional item is 
available:

Display reagent ion 
source settings

Displays the current values of the reagent ion 
source parameters.
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Chapter 5 Instrument Setup

This chapter explains the “Locking” feature in automated runs and 
describes the FT relevant topics of the data dependent settings in the 
Instrument Setup. It contains the following topics:

• “Using Locking in Automated Runs” on page 5-2

• “Data Dependent Settings” on page 5-3
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Using Locking in Automated Runs
To use locking in an automated run, use the Instrument Setup program. 
See Figure 5-1.

Note See “Locking” on page 2-11 for a basic description on using 
locking with FTMS analyzer scans. ▲

The Lock Mass List button on the right side of the Segment settings area 
displays a lock mass list editor dialog. See Figure 2-9 on page 2-11. 
Segment-related lock masses can be entered here. There are separate lists 
for positive ion and negative ion mode. If the lock mass for a segment is 
empty, no locking will be applied in the run and the external mass 
calibration will be used.

Figure 5-1. MS Detector Setup View—MS Detector Setup Page
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Data Dependent Settings
This section describes the FT relevant topics of the data dependent 
settings in the Instrument Setup.

Using Masses instead of Mass-to-Charge Ratios

Figure 5-2 shows the Global page of the Data Dependent Settings dialog 
box. Use the page to select dependent scan settings that apply to all 
dependent scans. 

Instrument Setup allows using mass units in the input fields of dialog 
boxes instead of mass-to-charge ratios. To enable this feature, select the 
check box on the Global page and click OK. From now on, you can 
enter just the uncharged masses of the most intensive peaks. It is not 
necessary anymore to consider all possible charge states. The Orbitrap 
Elite mass spectrometer determines the charge state from the full scan 
and converts these masses to mass-to-charge ratios. Enabling this feature 
affects the parameters in the data dependent settings as described below.

Figure 5-2. Data Dependent Settings dialog box—Global page
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Mass Units in Global Parameters

Global Mass Range is interpreted as masses. 
Therefore, a mass range of m/z 500–2000 
will allow selecting a M2+ peak at m/z 251, 
but will ignore a M2+ peak at m/z 1001.

Mass Widths Exclusion mass widths are interpreted as 
masses. Note that the isotope exclusion 
functionality will be based on masses. 
Therefore, if both a M2+ and M3+ peak 
show up for the same peptide in a full scan, 
only the more abundant charge state will 
be selected.
Parent mass widths are interpreted as 
masses.
Reject mass widths are interpreted as 
masses.

Dynamic Exclusion Dynamic exclusion mass widths are 
interpreted as masses. When a peak is 
dynamically excluded, the neutral mass is 
put on the list. Therefore, other charge 
states of the same mass will be excluded in 
future cycles.

Mass Tags Mass deltas are interpreted as masses. The 
mass deltas are converted back to 
mass-to-charge ratios based on the detected 
charge state of the selected peak. The 
partner must also have the same charge 
state. Mass tolerances are based on 
exclusion mass widths.

Isotopic Data Dependence Mass differences are interpreted as masses. 
The mass differences are converted back to 
mass-to-charge ratios based on the detected 
charge state of the selected peak.

Neutral Loss Neutral loss mass widths are interpreted as 
masses.

Product Product mass widths are interpreted as 
masses.
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Mass Units in Segment Parameters

Parent Mass List Input will be interpreted as neutral 
masses—not [M+H]+ or [M-H]+. If 
“MS Charge State” is specified in the mass 
list, this value is used to convert the mass 
back to a mass-to-charge ratio. If this is not 
specified, masses are converted to 
mass-to-charge ratios based on all charge 
states that are not on the rejection list. “4 
and up” is an allowed charge state, but the 
search is only performed for 4, and not 5, 
6, etc. If more than one charge state is 
identified, only the most abundant is 
selected.

Reject Mass List Input will be interpreted as neutral 
masses—not [M+H]+ or [M-H]+.

Charge State Because masses must be converted back to 
mass-to-charge ratios, the charge state must 
be known for any peak that is analyzed. 
Therefore, rejection of unassigned charge 
states is automatically enforced.

Neutral Loss Masses are interpreted as masses. The 
charge state used to convert back to 
mass-to-charge ratio is based on the peak 
being analyzed. The charge state of the 
potential partner must match the charge 
state of the peak.

Product Mass List Input will be interpreted as neutral 
masses—not [M+H]+ or [M-H]+.

Add/Sub Mass is interpreted as a mass and is 
converted to mass-to-charge based on the 
charge state of the selected peak.
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Preview Mode

Figure 5-3 shows the Current Segment page of the Data Dependent 
Settings dialog box.

If the preview mode for FTMS master scans is enabled on the Current 
Segment page, the data dependent decision is made on the basis of the 
FTmaster scan with lower resolution to increase the duty cycle. The 
resolution of the FTMS scan itself is not changed. Because the high 
resolution is usually not required to make the data dependent decision, 
it is recommended to enable the preview mode. 

To prevent making data dependent decisions on basis of 
lower-resolution preview spectra, disable this option. For example, if 
there are ions with high charge states to be examined, and the data 
dependent settings require charge state recognition of precursor ions, 
this might be a reason to turn off this option. Otherwise, the high 
charge state clusters may not be resolved and charge states will not be 
recognized in preview mode.

Figure 5-3. Data Dependent Settings dialog box—Current Segment page
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Monoisotopic Precursor Selection

Figure 5-4 shows Charge State page of the Data Dependent Settings 
dialog box.

If the monoisotopic precursor selection is enabled on the Charge State 
page, the data dependent scan is only performed for one molecular ion 
of the corresponding overall isotopic distribution if Dynamic Exclusion 
is enabled. 

This check box is only available on the Charge State page if the 
Advanced Features are turned on in the Orbitrap Elite menu of the 
Instrument Setup.

Note The algorithm for isotopic cluster recognition will handle correctly 
only such isotope distributions where the third peak (A + 2) is lower in 
intensity than the second peak (A + 1). For more complex isotope 
patterns (for example, ion containing Sn, Br, or multiple Cl atoms), it is 
recommended to clear the Enable monoisotopic precursor selection 
check box. ▲

Figure 5-4. Data Dependent Settings dialog box—Charge State page (Advanced Features on)
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Use Non-Peptide Monoisotopic Recognition

This check box is only available if monoisotopic precursor selection is 
active. If monoisotopic precursor selection is active and this box is not 
checked, precursor ions in FT master scans must match peptide-type 
isotopic distribution to identify the monoisotopic peak. If this box is 
selected, monoisotopic peaks will also be identified for small molecules 
and precursor ions with non-peptide-type isotopic distributions.

Enabling Charge State Dependent ETD Time

For data-dependent scans that use ETD activation1, you can allow the 
instrument to adjust the reaction time according to the charge state of 
the ions. Select this check box to have the instrument reduce the 
reaction time for highly charged ions and increase it for lowly charged 
ions.

1This feature is available only for the Orbitrap Elite ETD mass spectrometer.

Figure 5-5. Enabling charge state dependent ETD time
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Data Dependent FT SIM Scans

A data dependent FT SIM scan is performed around the center mass 
determined in a previous reference scan event if the check box “Same 
MS order as referenced scan event” is selected on the Current Scan 
Event page as shown in Figure 5-6. 

Repeat previous Scan Event with HCD

The Repeat previous scan event with HCD check box will only be 
available when all of the following requirements are fulfilled:

• Select an experiment type other than data dependent triple play, 
data dependent neutral loss MS3, or data dependent product MS3.

• Select a scan event greater than or equal to 3.

• Specify one or more parent ions in a previous scan event. 

• FTMS is selected as the mass analyzer for the current scan event.

• A neutral loss or product ion list is specified for the referenced scan 
event.

• Either option From neutral loss list or From product list is selected.

Figure 5-6. Data Dependent Settings dialog box—Current Scan Event page
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• HCD is selected as activation type on the Activation page. See 
page 5-13.

Select the check box to repeat the previous scan event with 
HCD activation type. A typical experiment to use this feature would be 
to trigger an HCD fragmentation experiment with a neutral loss 
observed in an ion trap MS/MS experiment. See Figure 5-7. 

Repeat previous Scan Event with ETD

The Repeat previous scan event with ETD check box1 will only be 
available when all of the following requirements are fulfilled:

• A neutral loss or product ion list is specified for the referenced scan 
event.

• Either option From neutral loss list or From product list is selected.

• ETD is selected as activation type on the Activation page. See 
page 5-13.

Figure 5-7. Current Scan Event page—Repeat previous scan event with HCD

1This feature is available only for the Orbitrap Elite ETD mass spectrometer.
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Select the check box to repeat the previous scan event with 
ETD activation type. A typical experiment to use this feature would be 
to trigger an ETD fragmentation experiment with a neutral loss 
observed in an ion trap MS/MS experiment. See Figure 5-8. 

Figure 5-8. Current Scan Event page—Repeat previous scan event with ETD



Instrument Setup
Data Dependent Settings

5-12 Orbitrap Elite Getting Started (P/N 1288180, Revision A) Thermo Fisher Scientific

Scan Width

The scan width of the data dependent FT SIM scan can be selected on 
the Scan widths page of the Data Dependent Settings dialog box. See 
Figure 5-9.

Figure 5-9. Data Dependent Settings dialog box—Scan Widths page
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Activation Type

On the Activation page of the Data Dependent Settings dialog box, use 
the Activation type list box to specify how the ions are activated for 
fragmentation during a data dependent experiment. See Figure 5-10. It 
has the following options:

• CID (Collision-induced dissociation)

• PQD (Pulsed-Q dissociation)

• ETD (electron transfer dissociation)1

Use ETD to fragment peptides and proteins. After selecting ETD, 
Normalized collision energy and Activation Q are not available and 
Supplemental Activation becomes available. See Figure 7-36 on 
page 7-39.

• HCD (higher energy CID)

Use HCD to obtain triple quadrupole-like fragment ion spectra. If 
you select HCD, the Activation Q spin box becomes unavailable.

1This feature is available only for the Orbitrap Elite ETD mass spectrometer.

Figure 5-10. Data Dependent Settings dialog box—Activation page
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FT HCD

The FT HCD page of the Data Dependent Settings dialog box will only 
be available when FTMS is selected as the mass analyzer for the current 
scan event. See Figure 5-11.

The FT HCD page offers two modes for choosing the first mass of the 
dependent scan:

• a mass with a fixed m/z value

To change the m/z value, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. You can 
set m/z to any value from 50 to 4000; default is 100. Alternatively, 
enter a value in the spin box text field.

• a mass with an m/z value that is relative to the precursor mass.

To change the percentage, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. You can 
set the percentage to any value from 0 to 4; default is 0.25. 
Alternatively, enter a value in the spin box text field.

Note The highest m/z that the Orbitrap Elite mass spectrometer can 
analyze is equal to approximately 20 times the m/z of the first mass. ▲

Figure 5-11. Data Dependent Settings dialog box—FT HCD page
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FT ETD

The FT ETD page1 of the Data Dependent Settings dialog box will only 
be available when FTMS is selected as the mass analyzer for the current 
scan event. See Figure 5-12.

Note The highest m/z that the Orbitrap Elite mass spectrometer can 
analyze is equal to approximately 20 times the m/z of the first mass. ▲

The FT ETD page offers two modes for choosing the first mass of the 
dependent scan:

• a mass with a fixed m/z value

To change the m/z value, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. You can 
set m/z to any value from 50 to 4000; default is 100. Alternatively, 
enter a value in the spin box text field.

1This feature is available only for the Orbitrap Elite ETD mass spectrometer.

Figure 5-12. Data Dependent Settings dialog box—FT ETD page
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• a mass with an m/z value that is relative to the precursor mass.

To change the percentage, click the arrows in the spin box to 
increment [up arrow] or decrement [down arrow] the value. You can 
set the percentage to any value from 0 to 4; default is 0.25. 
Alternatively, enter a value in the spin box text field.

MSn Settings for HCD Experiments

Similar to the Define Scan dialog box, use the Instrument Setup to 
select the Activation type (CID/PQD/HCD). See “MSn Settings” on 
page 2-12. Use HCD to obtain triple quadrupole-like fragment ion 
spectra. If you select HCD as activation type, the HCD charge state 
spin box becomes available and the Activation Q spin box is disabled. 
See Figure 5-13.

MSn Settings for ETD Experiments

In the Orbitrap Elite ETD mass spectrometer, use the Instrument Setup 
to select ETD as the Activation type. See Figure 5-14. Use ETD to 
fragment peptides and proteins at the amide-N to alpha-C bond to 
produce c- and z-type fragment ions. Selecting ETD as activation type 
has the following consequences:

• The Supplemental Activation Check box becomes available and 
allows entering the corresponding charge state in the spin box. 

Figure 5-13. MS Detector Setup Page—Scan event settings with HCD experiment
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• The Normalized Collision Energy spin box and the Activation Q 
spin box are disabled.

Figure 5-14. MS Detector Setup Page—Scan event settings with ETD experiment
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Chapter 6 Instrument Configuration

This chapter gives instructions on how to configure your instrument. It 
contains the following topics:

• “Starting Instrument Configuration” on page 6-2

• “FT Settings Page” on page 6-3

• “FT Mass Lists Page” on page 6-4
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Starting Instrument Configuration
Use the Orbitrap Elite Configuration dialog box to enter Orbitrap Elite 
MS configuration information on several pages, including the 
FT Settings page and the FT Manual Calibration page.

❖ To display the Orbitrap Elite Configuration dialog box

1. Choose Programs > Thermo Foundation 2.0 > Instrument 
Configuration to display the Instrument Configuration dialog box.

2. Click the Orbitrap Elite MS button in the Configured Devices area. 
See Figure 6-1.

3. Click Configure to open the Orbitrap Elite Configuration dialog 
box.

The pages of this dialog box are described in the following topics.

See “Configuring the Reagent Ion Source” on page 7-8 for information 
about the Reagent Ion Source page of the Orbitrap Elite Configuration 
dialog box, which is available for the Orbitrap Elite ETD mass 
spectrometer.

Figure 6-1. Instrument Configuration dialog box
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FT Settings Page
Use the FT Settings page of the Orbitrap Elite Configuration dialog box 
to edit the FTMS analyzer temperature setpoint. See Figure 6-2.

Using the FT Settings page of the Orbitrap Elite Configuration dialog 
box, you can select the following parameters:

Note Configuration changes will become effective when you reboot 
your instrument. ▲

Figure 6-2. Orbitrap Elite Configuration dialog box—FT Settings page

FTMS analyzer 
temperature setpoint (°C)

Enter the desired temperature for the 
Orbitrap analyzer chamber. The default 
value is 26.
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FT Mass Lists Page
Use the FT Mass Lists page of the Orbitrap Elite Configuration dialog 
box to edit the calibration mass lists, which are displayed in the 
FT Manual page of the Calibrate dialog box. See Figure 6-3. It is also 
possible to import or export a mass list as a text file. 

The FT Mass Lists page of the Orbitrap Elite Configuration dialog box 
has the following parameters:

Figure 6-3. Orbitrap Elite Configuration dialog box—FT Mass Lists page

Name This list box lists the names of the factory supplied 
and user created mass lists. 

Mass List This table lists the mass-to-charge ratios of the ions 
that you are using to calibrate the Orbitrap mass 
analyzer. You can select an existing mass list in the 
Name list box, or you can create or modify a mass 
list by clicking on and editing the entries in the 
Mass List table. 

Save Click Save to save the mass list with the name that 
is selected in the Name list box.

Save As Click Save As a to save the mass list with a new 
name.

Delete Click Delete to delete the mass list that is selected 
in the Name list box.

Import Click Import to import a mass list that is a text file.
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Export Click Export to export a mass list to a text file.

Show Factory Lists Select this check box to show the factory calibration 
mass lists in Tune Plus. 
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Chapter 7 Orbitrap Elite ETD Instruments

This chapter describes only the Orbitrap MS relevant differences in 
instrument settings and procedures with respect to using an Orbitrap 
Elite ETD instrument. See also the previous chapters of this manual and 
the Orbitrap Elite Hardware Manual. 

This chapter contains the following topics:

• “Tune Plus Window of the Orbitrap Elite ETD Mass Spectrometer” 
on page 7-2

• “Configuring the Reagent Ion Source” on page 7-8

• “Powering On the ETD Module and Viewing Reagent Ion Spectra” 
on page 7-10

• “Tuning the Reagent Ion Optics” on page 7-12

• “Performing an ETD Infusion Experiment” on page 7-27

• “Creating an Xcalibur Instrument Method That Uses ETD 
Activation” on page 7-35

• “Angiotensin I Solutions” on page 7-41

For additional information concerning ETD, refer to the ETD Module 
Hardware Manual and the ETD Module Getting Started Guide.

Note If your instrument is equipped with a reagent ion source, you need 
to configure the reagent ion source in Instrument Configuration to get 
access to all reagent ion source relevant settings of Tune Plus and 
Instrument Setup. See “Configuring the Reagent Ion Source” on 
page 7-8. ▲
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Tune Plus Window of the Orbitrap Elite ETD Mass Spectrometer
This section describes the differences in the Tune Plus window of an 
Orbitrap Elite ETD instrument. Spectrum view and Graph view show 
no differences to the standard instrument. They are described in 
Chapter 2: “Tune Plus Window”.

Status View

The Tune Plus window shows a schematic view of the Orbitrap 
Elite ETD instrument. See Figure 7-1. The instrument control icon in 
the toolbar allows accessing parameters for the reagent ion source and 
the reagent ion optics.

Figure 7-1. Status View for Orbitrap Elite ETD MS

Reagent Ion Source instrument control iconReagent Ion Optics icon
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The color of the Reagent Ion Source control icon indicates the status of 
the reagent ion source:

The Status view—All page additionally displays information about 
reagent ion source, reagent ion optics, reagent vacuum, reagent 
turbomolecular pump, and reagent power supplies.

Scan Mode Menu

This section describes the elements of the Scan Mode menu that are 
different from the standard instrument.

Define Scan Dialog Box

As described in Chapter 2: “Tune Plus Window”, you can choose the 
analyzer type (Ion Trap or FTMS), mass range, resolution, and scan 
type. See Figure 7-2. You can as well define the scan range (for example, 
First Mass–Last Mass window). 

Reagent ion source off

Reagent ion source on
The status of the filament is shown in the Status view—All 
page.

Figure 7-2. Define Scan dialog box for Orbitrap Elite ETD MS
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When you select ETD as Activation Type in the MSn Settings, the 
Supplemental Activation check box becomes available. Select this check 
box to enable supplemental activation of ETD MS/MS and MSn.

Use the SA Energy spin box to enter the percentage of the energy that 
should be used for supplemental activation. The available range is 0 to 
20%.

Use the SA Charge State spin box to enter the charge state of the parent 
ion for supplemental activation. Available charge states are 2 to 10.

Setup Menu

This section describes the elements of the Setup menu that are different 
from the standard instrument.

Injection Control Dialog Box—Reagent Page

The number of reagent ions admitted into the linear trap is regulated by 
the parameters in the Reagent page in the Injection Control dialog box. 
See Figure 7-3. Open the Reagent page in the Injection Control window 
by clicking the Injection Control instrument control graphic or click 
Setup > Injection Control > Reagent.

See “Viewing the Injection Reagent Settings” on page 7-27 for 
information about the parameters available on this dialog box.

Figure 7-3. Injection Control dialog box—Reagent page
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Reagent Ion Optics Dialog Box

Use the Reagent Ion Optics dialog box to specify voltages for the reagent 
ion source lenses, the back lens, and the transfer multipole. Usually, the 
reagent ion optics parameters are optimized by the automatic tune 
procedure to maximize the transmission of reagent ions from the reagent 
ion source to the linear ion trap.

You may obtain small improvement in the signal by manual tuning and 
changing the settings. You can change the settings in this dialog box 
only after selecting the View Reagent Ion Spectra check box in the 
Reagent Ion Source dialog box. See Figure 7-4. See “Tuning the Reagent 
Ion Optics” on page 7-12 for more information.

Note The reagent ion optics lenses have broad optimums—except the 
back lens. Increasing or decreasing the back lens offset by 3 or 4 V can 
significantly reduce the signal. ▲

Reagent Ion Source Dialog Box

Use the Reagent Ion Source dialog box to set selected ETD reagent ion 
source parameters. See Figure 7-5 on page 7-6. The actual parameter 
values are shown on the right side of the dialog box.

Figure 7-4. Activating Reagent Ion Optics dialog box
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Use the Reagent Ion Source On check box to turn on or off the reagent 
ion source, including the vial heaters. If the reagent vials are not at their 
target temperatures, a “Please Wait” message window appears. Typically, 
heating takes 5 to 10 minutes. Turn off the reagent ion source if you do 
not plan to use it for an extended period, overnight for example.

Use the Filament On check box to turn on or off the filament, which 
produces electrons. When the reagent vials reach their target 
temperatures, the filament automatically turns on and the Filament On 
check box automatically shows a check mark. (You can force the 
filament to turn on before the vials reach their target temperatures by 
selecting the check box.) To prolong the lifetime of the filament, turn it 
off if the reagent ion source will not be in use for an hour or more.

Click Open Probe Interlock to evacuate the inlet valve block to a target 
pressure of less than 0.1 mTorr. When the target pressure is achieved, a 
message states that you can open the ball valve. Refer to the Orbitrap 
Elite Hardware Manual for maintenance instructions for the reagent ion 
source.

When you select the View Reagent Spectra check box, the following 
actions become possible:

• The injection of analyte ions, but not reagent ions, into the mass 
analyzer for mass analysis is stopped. This allows measuring reagent 
ion intensity and also checking for reagent contamination by 
observing the mass spectrum.

Figure 7-5. Reagent Ion Source dialog box
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• You can change the parameter values in the Reagent Ion Optics 
dialog box. See page 7-5.

• You can autotune the reagent ion source. See page 7-12.

Vacuum Dialog Box – Reagent Page

Use the Reagent page of the Vacuum dialog box to switch on the ion 
gauge in the ETD Module. It also displays the pressure readings of the 
ion gauge and the Convectron gauge in the ETD Module. See 
Figure 7-6.

Figure 7-6. Reagent page of the Vacuum dialog box
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Configuring the Reagent Ion Source
After you have installed the reagent vials for the ETD Module as 
described in the Orbitrap Elite Hardware Manual, you have to configure 
the reagent ion source of the Orbitrap Elite ETD mass spectrometer.

❖ To configure the reagent ion source

1. From the Instrument Configuration window, click Orbitrap Elite 
MS in the Configured Devices area.

2. Click Configure to open the Orbitrap Elite Configuration dialog 
box.

3. Click Reagent Ion Source in the left hand section of the Orbitrap 
Elite Configuration window. Use the Reagent Ion Source page of the 
Configuration dialog box to configure the reagent ion source and to 
activate the cooling gas. See Figure 7-7.

4. Select the Reagent Ion Source Configured check box as shown in 
Figure 7-7.

5. In the Vial 1 row, click the Reagent Name list box and select 
Fluoranthene. The Fluoranthene Vial 1 Reagent Mass, Activation 
Type, and default Vial Temperature will appear in the table.

Figure 7-7. Enabling the reagent ion source
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Caution The empty vial in the Vial 2 heater is an integral part of the 
carrier/CI gas system. It is necessary to keep the carrier/CI gas system 
closed to the laboratory. If no vial is placed in the Vial 2 heater:

• The carrier/CI gas containing the reagent may escape to the 
laboratory causing a safety problem.

• The ETD Module will not operate correctly and the filament will 
burn out. ▲

6. Select the Use Cooling Gas check box as shown in Figure 7-8.

Note Select the Use Low Vial Temperature check box to heat the vial to 
90 °C, rather than 108 °C. Operating at the lower vial temperature will 
reduce the rate of reagent consumption and may extend the lifetime of 
the filament. However, it might increase the reagent injection time. ▲

7. Click OK in the Orbitrap Elite Configuration dialog box.

A message box informs you that for the configuration changes to 
take effect, you will need to reboot the data system and then the 
mass spectrometer.

8. Click Done in the Instrument Configuration window.

9. Reboot the data system.

10. Reboot the Orbitrap Elite ETD mass spectrometer.

The system software is now configured for using the reagent ion source 
of the Orbitrap Elite ETD system.

Figure 7-8. Orbitrap Elite Configuration dialog box—Reagent Ion Source page
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Powering On the ETD Module and Viewing Reagent Ion Spectra
After the reagent vials have been installed as described in the Orbitrap 
Elite Hardware Manual, power on the ETD Module by placing the 
Orbitrap Elite ETD mass spectrometer in On mode. Turn on the 
reagent ion source to view the reagent ion spectra. 

Powering On the ETD Module

❖ To power on the ETD Module

1. Toggle the ETD Module service switch to the Operating Mode 
(ON) position if it is not already in this position. 

2. Toggle the Orbitrap Elite MS FT Electronics switch to the On 
position. This turns the ETD Module on if the ETD Module 
service switch is already in the Operating Mode (ON) position. 

For detailed instructions about starting up and shutting down the 
instrument, refer to the Orbitrap Elite Hardware Manual.

Turning On the Reagent Ion Source and Viewing Reagent Ion Spectra

Even when the ETD module is turned on, the reagent ion source within 
it is not turned on until you turn it on.

❖ To turn on the reagent ion source

1. Click the Reagent Ion Source instrument control icon in the 
toolbar of the Tune Plus window. (See icon in margin and 
Figure 7-1 on page 7-2.) The Reagent Ion Source dialog box 
appears. (See Figure 7-5 on page 7-6.) 

2. In the Reagent Ion Source dialog box, click the Reagent Ion Source 
On check box. (See Figure 7-5.) If the reagent vials are not at their 
target temperature, a message box appears. See Figure 7-9. When 
the reagent vials reach their target temperature, voltage is applied to 
the ETD Module ion optics. The filament automatically turns on; 
the Filament On check box automatically shows a check mark and 
its actual condition switches from Off to On. 

Figure 7-9. Message box: Reagent Vial NOT At Temperature!
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❖ To view the reagent ion spectra

1. Select the View Reagent Ion Spectra check box in the Reagent Ion 
Source dialog box. See Figure 7-10.

2. Reagent ion peaks appear in the Spectrum view. See Figure 7-10.

If the spectrum is satisfactory, proceed to the next step. If the 
spectrum is not satisfactory, tune the reagent ion optics as described 
in “Tuning the Reagent Ion Optics” on page 7-12.

3. Clear the View Reagent Ion Spectra check box.

The Tune Plus Spectrum view from the ETD module is cleared.

Figure 7-10. Tune Plus window showing the fluoranthene radical anion mass spectrum

View reagent ion 
spectra
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Tuning the Reagent Ion Optics
This section describes how to tune the ETD Reagent Ion Optics settings 
to obtain optimized reagent ion transmission. 

There are three ways to tune the ion optics within the reagent ion 
source: automatically, semi-automatically, and manually.

• “Automatically Tuning the Reagent Ion Source“, next section

• “Manually Tuning the Reagent Ion Source” on page 7-14

• “Semi-Automatically Tuning the Reagent Ion Optics” on page 7-17

Automatically tuning the reagent ion source is the best method for most 
situations. In some cases it may be appropriate to perform manual 
tuning. Choose manual tuning to manually optimize reagent ion optics 
parameters and reagent ion source parameters that are not automatically 
tuned such as Emission Current, Electron Energy, and CI gas pressure. 
Manual tuning is done by observing the effects of adjusting these 
parameters on the reagent ion signal intensity. 

Note Tune Plus provides an evaluation procedure for CI gas pressure 
under Diagnostics > Diagnostics > Tools > System evaluation > 
Reagent CI gas pressure evaluation. Thermo Fisher Scientific 
recommends performing this procedure after replacing the filament 
and/or the ion volume. ▲

Use semi-automatic tuning to optimize each lens setting individually 
within an optimization range and according to the step size you select.

Automatically Tuning the Reagent Ion Source

Automatically tuning the reagent ion source assures the best ion optics 
settings for optimum transmission of reagent ions (fluoranthene). 

❖ To automatically tune the reagent ion source

1. On the Windows taskbar, choose Start > All Programs > Thermo 
Instruments > LTQ > LTQ Tune.

The Tune Plus window opens. (See Figure 7-1 on page 7-2.)

2. Click the On/Off/Standby button to take the Orbitrap Elite ETD 
mass spectrometer out of Standby mode and turn it on.

3. Click the Display Graph View button.

4. If the reagent ion source is not on, turn it on as described in 
“Turning On the Reagent Ion Source and Viewing Reagent Ion 
Spectra” on page 7-10. 

On Off Standby
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5. In the Reagent Ion Source dialog box, select the View Reagent Ion 
Spectra check box. (See Figure 7-11.)

6. Click the Tune button. (See icon in margin.) The Tune dialog box 
appears. 

7. The left side of the underlying view shows the reagent ion spectra 
(fluoranthene). See Figure 7-12 on page 7-14. The center view 
shows one of the parameters that are automatically tuned (back lens 
potential tuned to maximize the signal intensity at m/z 202). 

8. Click the Automatic tab in the Tune dialog box if it is not already 
the active tab. The Automatic page of this window appears. 

9. Click Start in the Automatic page of the Tune dialog box. The 
system will begin automatically tuning the ion optics of the reagent 
ion source. The Status box of the dialog box indicates that 
automatic tuning is completed by displaying the message, 
“Optimization Complete”. This message will also indicate the 
percentage change in the reagent ion signal intensity at m/z 202 
relative to the prior value. A typical reagent signal intensity is about 
1–2E7 in centroid mode when the system has been cleaned and the 
ion volume is new. 

Figure 7-11. Activating Reagent Ion Source tuning
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10. Rerun Automatic Tune if the percentage change is greater than 
20%. This is an iterative process. At some point there will be no 
more improvements in signal intensity. 

Manually Tuning the Reagent Ion Source

❖ To manually tune the reagent ion source

1. Click the Display Graph View icon in Tune Plus. 

2. If the reagent ion source is not on, open the Reagent Ion Source 
dialog box and turn on the reagent ion source as described in 
“Turning On the Reagent Ion Source and Viewing Reagent Ion 
Spectra” on page 7-10. 

3. In the Reagent Ion Source dialog box, select the View Reagent Ion 
Spectra check box. See Figure 7-10 on page 7-11.

Figure 7-12. Tune Plus window with Automatic page of Tune dialog box displayed

Automatic tab
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4. Click the Reagent Ion Optics icon at the top of the Tune Plus 
window. (See icon in margin and Figure 7-13.) The Reagent Ion 
Optics dialog box appears. 

5. Click the Tune button in Tune Plus. The Tune dialog box appears. 

You can also tune the reagent ion source. When the Reagent Ion 
Source dialog box is open (See Figure 7-5 on page 7-6.), click the 
Tune button in Tune Plus. 

6. Click the Manual tab in the Tune dialog box if the Manual page is 
not already visible. (See Figure 7-14 on page 7-16.)

7. Select the Reagent Ion from Vial 1 check box. 

Figure 7-13. Tune Plus window with Reagent Ion Optics dialog box

Reagent Ion Optics icon
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8. Click Start. 

The Graph view displays a plot of the reagent ion intensity. See 
Figure 7-15 on page 7-17. You can observe the response of the 
reagent ion intensity to changes in the lens parameters (Reagent Ion 
Optics dialog box) and Emission Current, CI gas pressure, and 
Electron Energy (Reagent Ion Source dialog box). Adjust these 
parameters to achieve the maximum reagent ion signal intensity. 

Note Increasing the emission current might shorten the filament life 
time. Therefore, Thermo Fisher Scientific recommends readjusting the 
emission current only in exceptional circumstances. ▲

Figure 7-14. Reagent Ion Source Tune dialog box – Manual page
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Semi-Automatically Tuning the Reagent Ion Optics

Use the semi-automatic tuning method to fine-tune the lens parameters 
to a range of settings and in step increments.

❖ To semi-automatically tune the reagent ion optics

1. On the Windows taskbar, choose Start > All Programs > Thermo 
Instruments > LTQ > LTQ Tune.

The Tune Plus window opens. (See Figure 7-1 on page 7-2.)

2. Click the Display Graph View button.

3. If the Reagent Ion Source is not on, turn it on:

a. In the Tune Plus window, choose Setup > Reagent Ion Source.
The Reagent Ion Source dialog box opens. (See Figure 7-5 on 
page 7-6.)

Figure 7-15. Tune Plus window showing the Display Graph view for manual tuning of the Reagent Ion Source 
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b. Select the Reagent Ion Source On check box.
If the reagent vials are not at their target temperature, a message 
appears:

Reagent Vial NOT At Temperature! Please wait . . .

When the reagent vials reach their target temperature, voltage is 
applied to the Orbitrap Elite ETD system’s ion optics. The 
filament automatically turns on (the Filament On check box 
automatically shows a check mark and its actual condition 
switches from Off to On).

4. In the Reagent Ion Source dialog box, select the View Reagent Ion 
Spectra check box.

5. In the Control/Scan Mode toolbar, click the Tune button.

The Tune dialog box opens with the Automatic page shown by 
default (Figure 7-11 on page 7-13).

Figure 7-16. Semi-Automatic page of the Tune dialog box
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6. Click the Semi-Automatic tab. The Semi-Automatic page opens. See 
Figure 7-16 on page 7-18.

7. From the What to Optimize list, select the item you want to tune:

• Reagent ion lens 1 (V)

• Reagent ion gate lens (V)

• Reagent ion lens 2 (V)

• Reagent ion lens 3 (V)

• Back Multipole Offset (V); see also “Tuning the Quadrupole 
Mass Filter” on page 7-21

• Back lens (V)

8. Adjust the settings in the Optimization Range area:

• Start

• End

• Step

9. Click Start.

The results of your settings are shown in the Results area.
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Viewing the Current Reagent Ion Optics Settings

❖ To view the current Reagent Ion Optics settings

1. Click the Reagent Ion Optics instrument control icon in the Tune 
Plus window to open the Reagent Ion Optics dialog box. The 
parameters in the Reagent Ion Optics dialog box have been 
optimized by the Auto Tune process. See Figure 7-17.

Note When the View Reagent Ion Spectra check box in the Reagent Ion 
Source dialog box is not selected, the parameters in the Reagent Ion 
Optics dialog box cannot be changed. ▲

2. Click OK to close the Reagent Ion Optics dialog box. 

Figure 7-17. Reagent Ion Optics dialog box
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Saving Your ETD Tune Method

After tuning is complete, save the ETD Tune parameters in a tune 
method. 

❖ To save the tune method

1. On the File/Display toolbar, click the Save button.

The Save As dialog box opens.

2. Browse to choose a location and specify a file name.

3. Click Save.

Tuning the Quadrupole Mass Filter

Stable calibration of the quadrupole mass filter between the linear ion 
trap and the C-Trap is achieved by manually adjusting the Back 
Multipole DC Offset voltage.

❖ To adjust the Back Multipole DC Offset voltage

1. Open the Toggles page in the Diagnostics dialog box.

2. Set Isolate reagent ion to On. See Figure 7-18.

Figure 7-18. Activating Reagent Ion Isolation
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3. In the Reagent Ion Source dialog box, select the View Reagent Ion 
Spectra check box.

4. Open the Tune dialog box and perform a semi-automatic tune of 
the Back Multipole Offset with the settings shown in Figure 7-19 on 
page 7-22 (Start 0, End 40, Step 0.35).

5. Search for a local maximum just before the oscillations on the signal 
start. (In the example shown in Figure 7-21, that would be at about 
17 V). 

6. Open the Reagent Ion Optics dialog box. Enter the new value for 
the Back Multipole Offset voltage into the respective spin box and 
click Apply.

7. Open the Calibrate dialog box and perform a semi-automatic 
calibration of the Reagent Ion Selection. See Figure 7-20 on 
page 7-23 and Figure 7-23 on page 7-25.

Figure 7-19. Semi-automatic tune of the Back Multipole Offset DC voltage
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Choosing the Operating Point for the Quadrupole Mass Filter

The performance of the quadrupole mass filter strongly depends on the 
kinetic energy (that is, DC Offset) of the ions. If the kinetic energy is 
too low it causes a poor transmission; if the kinetic energy is too high it 
leads to oscillations (noding) of the signal.

In the example shown in Figure 7-21, noding starts at above 20 V. In 
this region, the signal is fragile. Depending on the DC Offset (for 
comparison: 10 V, 17 V, and 32 V; red points) the calibration curves 
look differently.

The best operating point for the filter is the immediate region before the 
oscillations start. In the example, that would be the range between 15 V 
and 20 V.

Figure 7-20. Calibrating the Reagent Ion Selection
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If the DC Offset is chosen too low, intensity losses in the filter are too 
large. During the calibration, the signal still increases after the stable 
region is reached. See Figure 7-22. As a consequence, the transmission at 
the operating point of the filter is poor.

With offset voltages between 15 V and 20 V, no noding is visible. See 
Figure 7-23. The transmission reaches a maximum shortly after the start 
of the stable region, resulting in a high transmission at optimum filter 
efficiency. The calibration results in a broad plateau with constant 
intensity.

Figure 7-21. Dependence of the signal from the DC Offset

Figure 7-22. Chosen DC Offset (10 V) is too low for calibration
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If the DC Offset is chosen too low, strong oscillation on the signal 
occur. See Figure 7-24. This creates problems when calibrating the filter. 
Because the maxima are very narrow, the anion signal is susceptible to 
changes of the ion optics (thermal drift of voltages, deterioration of the 
reagent source, etc.) Therefore, this region is not suitable for stable 
operation of the ETD system even though it may include the maximum 
of the anion intensity.

Figure 7-23. Point of optimum performance
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Figure 7-24. Chosen DC Offset (32 V) is too high for calibration
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„Noding“ in Quadrupoles

In quadrupole filters, the intensity of the nodes increases with the 
kinetic energy of the ions. See Figure 7-25.

Depending on the location of the nodes, the ions leave the quadrupole 
as an either convergent beam (good transmission) or divergent beam 
(bad transmission). Tuning the voltages moves the place of the nodes, 
leading to oscillations of the signal.

Figure 7-25. “Noding” in quadrupoles

 

  
Low kinetic energy: weakly developed nodes High kinetic energy: strongly developed nodes
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Performing an ETD Infusion Experiment
Procedures for performing an ETD infusion experiment are described in 
the following sections: 

• Viewing the Injection Reagent Settings

• Troubleshooting an AGC Target Error

• Obtaining an ETD Spectrum for Angiotensin I 

• Optimizing the Reagent Ion Reaction Time 

Viewing the Injection Reagent Settings

The number of reagent ions admitted into the linear ion trap is 
regulated by the parameters in the Reagent page of the Injection Control 
dialog box.

❖ To view the injection reagent ion settings

1. On the Windows taskbar, choose Start > All Programs > Thermo 
Instruments > LTQ > LTQ Tune.

The Tune Plus window opens. (See Figure 7-1 on page 7-2.)

2. Click the Injection Control instrument control graphic or click 
Setup > Injection Control to display the Injection control dialog 
box.

3. Click the Reagent tab to display the Reagent page. See Figure 7-26.

Figure 7-26. Injection Control dialog box—Reagent page
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The ETD Reagent Injection control consists of two parameters:

• The AGC Target parameter sets the target number of reagent anions 
to be injected into the linear ion trap to perform ETD. The default 
value for this parameter is 3E5.

• The Max. Inject Time (ms) parameter specifies the maximum 
amount of time that the system allows for anions to be injected into 
the trap. The default value for this time is 50 ms.

The reagent ion source injects reagent anions into the linear ion trap 
until the ETD AGC target is reached. The time allowed to reach the 
ETD AGC target cannot exceed the Maximum Injection time (the 
Maximum Injection time takes precedence over the AGC target).

Troubleshooting an AGC Target Error

If the AGC target is not reached due to the Maximum Injection time 
limit, the system displays an error message advising you that the 
AGC target has not been reached within the specified time limit 
(Maximum Injection time limit exceeded). This implies that the 
sensitivity of the reagent ion source is too low. To deal with this error, 
try the following procedures:

1. To increase the sensitivity of the source, run automatic tuning of the 
Reagent Ion Source. (See “Automatically Tuning the Reagent Ion 
Source” on page 7-12.)

2. The sensitivity decrease might be due to a dirty ion volume. A 
sufficiently contaminated ion volume causes the Maximum 
Injection time limit to be exceeded. Clean or change the ion 
volume. Refer to the Orbitrap Elite Hardware Manual for the 
procedure to do this.

3. The decrease of the signal might be due to a deformed filament. 
Change the filament. Refer to the Orbitrap Elite Hardware Manual 
for the procedure to do this.

4. The sensitivity decrease might be due to a dirty reagent ion source 
and its optics. A sufficiently contaminated reagent ion source and its 
optics causes the Maximum Injection time limit to be exceeded. 
Clean or change the reagent ion source and its optics. Refer to the 
Orbitrap Elite Hardware Manual for the procedure to do this.

5. Increase the emission current. However, doing this might shorten 
the filament life time.

6. Increase the Maximum Injection time limit. This is a temporary way 
to eliminate the error message. The Maximum Injection time limit 
can be increased up to the limits imposed by the overall scan cycle 
time.
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Maximum Injection Time limit and AGC Target influence the scan 
duration when obtaining an ETD spectrum.

Obtaining an ETD Spectrum for Angiotensin I

This section assumes that you are infusing Angiotensin I into the 
Orbitrap Elite ETD mass spectrometer according to the procedures 
described in the LTQ Series Getting Started manual. The recipe for this 
solution is given in “Angiotensin I Solutions” on page 7-41. 

❖ To obtain an ETD spectrum of Angiotensin I

1. Open the Tune Plus application. The Tune Plus window appears. 

2. Click On/Off/Standby to On. The mass spectrometer scans the 
infused analyte and produces a mass spectrum. See Figure 7-27.

3. Turn on the reagent ion source as explained in “Turning On the 
Reagent Ion Source and Viewing Reagent Ion Spectra” on 
page 7-10. 

On Off Standby

Figure 7-27. Tune plus window showing a mass scan of infused Angiotensin I
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4. Click Define Scan to display the Define Scan dialog box. See 
Figure 7-28 on page 7-30.

5. Enter the parent ion m/z of the 3+ charge state of Angiotensin I in 
the n=2 line of the Define Scan dialog box. 

Note The molecular weight of Angiotensin I (acetate hydrate) is 1296 u 
and the (M + 3H)3+ parent is giving rise of a signal at m/z 433.0. ▲

6. Select ETD from the Activation Type list box in the Define Scan 
dialog box. 

7. Click Apply in the Define Scan dialog box. 

8. Click OK in the Define Scan dialog box. The Define Scan dialog 
box closes and the ETD MS/MS spectrum of Angiotensin I appears 
in the Tune Plus window. See Figure 7-29 on page 7-31.

Figure 7-28. Define Scan window with the Activation Type ETD

Activation Type=ETD
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Optimizing the Reagent Ion Reaction Time

Typically, the system default Reagent Ion Reaction Time of 100 ms is 
appropriate for doubly charged ions. In some cases it is helpful to obtain 
an optimized Reagent Ion Reaction Time for your specific analyte, 
especially for ions with higher charge states. The procedures presented 
in this topic assume that your system is generating the reagent ions as 
described in “Turning On the Reagent Ion Source and Viewing Reagent 
Ion Spectra” on page 7-10. 

❖ To obtain an optimized reagent ion reaction time

1. Turn on ETD activation for the analyte of interest (Angiotensin I in 
this case). 

2. On the Control/Scan Mode toolbar, click the Define Scan button. 
to display the Define Scan dialog box. 

3. Enter the parent ion mass for the analyte of interest.

4. From the Act. Type list, select ETD. (See Figure 7-28 on page 7-30.)

Figure 7-29. ETD MS/MS spectrum of Angiotensin I
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5. Click Tune. The Tune dialog box opens with two additional tabs 
displayed for tuning ETD. See Figure 7-30 on page 7-32. 

6. Click the Reagent Ion Reaction Time tab in the Tune dialog box. 
See Figure 7-30. 

7. Optimize on either the total ion current of the product ions (TIC) 
or the m/z of particular product ions. 

• Optimize on the total ion current (TIC) of the product ions:

i. Click TIC in the What To Optimize On section of the Tune 
dialog box. (See Figure 7-30.) 

ii. Click Start. The software generates a graph of the product 
ion TIC versus reaction time. The Status box of the Tune 
dialog box shows the optimized reagent ion reaction time 
after the Tune process is completed. 

iii. A pop up dialog asks if you want to accept the optimized 
value. If you accept the optimized value, the reagent ion 
reaction time is set to this optimized value in the Define 

Figure 7-30. Tune and Define Scan windows open in Tune Plus

Reagent Ion Reaction Time tab Total Ion Current (TIC)Tune
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Scan dialog box. Otherwise, it is restored to its previous 
value. 

The reagent ion reaction time is now optimized based on the total 
ion current. 

• Optimize on the m/z of product ions:

i. Click Product Ion Mass in the What To Optimize On 
section of the Tune dialog box. See Figure 7-31. The spin 
box adjacent to Product Ion Mass becomes active. 

ii. Enter the m/z of the fragment of interest into the spin box. 

iii. Click Start. The software generates a graph of intensity of 
the m/z of interest versus reaction time. The Status box of 
the Tune dialog box shows a reagent ion reaction time after 
the Tune process is completed. 

iv. A pop up dialog asks if you want to accept the optimized 
value. If you accept the optimized value, the reagent ion 
reaction time is set to this optimized value in the Define 

Figure 7-31. Tune window showing Product Ion Mass selected for Reagent Ion Reaction Time Optimization

Product Ion Mass
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Scan dialog box. Otherwise, it is restored to its previous 
value. 

The reagent ion reaction time is now optimized based on a 
particular m/z of product ions. 
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Creating an Xcalibur Instrument Method That Uses ETD Activation
❖ To create an Xcalibur instrument method that uses ETD activation

1. Open the Xcalibur application (for example, from the Microsoft 
Windows desktop). The Roadmap Home Page appears. See 
Figure 7-32.

2. Click the Instrument Setup icon in the Roadmap Home Page.

3. Click General MS or MSn in the Select Experiment Type section of 
the New Method view. See Figure 7-33 on page 7-36. 

Figure 7-32. Xcalibur Roadmap Home Page
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4. Click the MS Detector Setup tab if this is not already the selected 
tab in the Untitled-Instrument Setup window. See Figure 7-34. 

5. Load the appropriate Tune Method (for example, a method saved as 
described in “Saving Your ETD Tune Method” on page 7-21).

Figure 7-33. New Method view in Xcalibur Instrument Setup
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6. Choose Scan Events to be 2 or more in the Segment 1 Settings 
portion of the MS Detector Setup view. See Figure 7-35 on 
page 7-38.

7. Select the Scan Event 2 bar (or the bar for a Scan Event >2). See 
Figure 7-35. 

Figure 7-34. Xcalibur MS Detector Setup view
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8. Select the Dependent Scan check box at the lower left corner of the 
MS Detector Setup view. (See Figure 7-35.) The adjacent Settings 
button becomes active. 

9. Click Settings. A Data Dependent Settings dialog box appears. See 
Figure 7-36 on page 7-39.

Figure 7-35. Xcalibur Instrument Setup

Settings (active when Dependent Scan is selected)Dependent Scan

Scan Events Scan Event bar
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10. In the Data Dependent Settings dialog box, do the following: 

a. Choose Scan Event > Activation in the menu on the left side of 
the window.

b. Select an Activation Type: ETD, CID, or PQD. The choice of 
Activation Type may be different for each Scan Event. 

c. For Default Charge State use values of 2 or more. 

d. For Isolation Width use values between 2 and 4. 

e. The Activation Time is either left at its default value or chosen 
as discussed in “Optimizing the Reagent Ion Reaction Time” on 
page 7-31. 

f. Click OK to close the Data Dependent Settings dialog box.

Figure 7-36. Data Dependent Settings dialog box in MS Detector Setup—Activation page
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11. Click File > Save As to save your Xcalibur method under the file 
name of your choice. (See Figure 7-37.) This method can be chosen 
and run when Sequence Setup is chosen in the Xcalibur Roadmap 
Home Page. (See Figure 7-32 on page 7-35.) Refer to your Xcalibur 
Help and the previous chapters of this manual for information 
about the other Data Dependent settings. 

Figure 7-37. Save As window in Xcalibur Instrument Setup, MS Detector Setup view
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Angiotensin I Solutions
This section provides instructions for the preparation of solutions 
containing Angiotensin I (acetate hydrate). A stock solution is diluted to 
make a test solution. The test solution is used to demonstrate the 
application of the Orbitrap Elite ETD mass spectrometer and to 
optimize the reagent ion reaction time.

Handle Angiotensin I in accordance with its Material Safety Data Sheet 
(MSDS).

Note Store and handle all chemicals in accordance with standard safety 
procedures. The Material Safety Data Sheet (MSDS) describing the 
chemicals being used should be freely available to laboratory personnel 
for them to examine at any time. Material Safety Data Sheets provide 
summarized information on the hazard and toxicity of specific chemical 
compounds. MSDSs also provide information on the proper handling 
of compounds, first aid for accidental exposure, and procedures for 
cleaning spills or dealing with leaks. ▲

Producers and suppliers of chemical compounds are required by law to 
provide their customers with the most current health and safety 
information in the form of an MSDS. Read the MSDS for each 
chemical you use. Dispose of all laboratory reagents in the appropriate 
way. (Refer to the MSDS.)

The Angiotensin I in your ETD Reagent Kit (Thermo Reagent Kit 
P/N 98000-62008, Thermo Angiotensin P/N 00301-15517) is 
Sigma/Aldrich #A9650.

The Angiotensin I MSDS is obtained by clicking the MSDS link at:

www.sigmaaldrich.com/catalog/search/ProductDetail/SIGMA/A9650

Other potentially hazardous chemicals used in the procedures in this 
section include:

• Glacial acetic acid

• Methanol

Handle these chemicals in accord with their MSDS documents.

Warning Avoid exposure to potentially harmful materials.
Always wear protective gloves and safety glasses when you handle 
solvents or corrosives. Also contain waste streams and use proper 
ventilation. Refer to your supplier's Material Safety Data Sheet (MSDS) 
for proper handling of a particular solvent. ▲

http://www.sigmaaldrich.com/catalog/search/ProductDetail/SIGMA/A9650


Orbitrap Elite ETD Instruments
Angiotensin I Solutions

7-42 Orbitrap Elite Getting Started (P/N 1288180, Revision A) Thermo Fisher Scientific

Preparing the Angiotensin I Stock Solution

❖ To prepare an Angiotensin I stock solution

1. Obtain the 1 mg vial of Angiotensin I in your accessory kit.

2. Add 382 μL of water, 382 μL of methanol, and 8 μL of glacial acetic 
acid to the 1 mg of Angiotensin I.

3. Ensure that the Angiotensin I is thoroughly dissolved.

4. Label the vial Angiotensin I stock solution and store it in a freezer until 
it is needed.

Preparing the Angiotensin I Test Solution

❖ To prepare an Angiotensin I sample solution

1. Pipet 100 μL of the stock solution (1nmol/μL) of Angiotensin I into 
a clean polypropylene microcentrifuge tube.

2. Add 900 μL of 50:50 methanol/water (0.1% acetic acid) to the tube.

3. Mix this solution (100 pmol/μL) thoroughly.

4. Pipet 19.8 mL of 0.1% acetic acid—50:50 methanol/water into a 
clean 20 mL glass scintillation vial.

5. Add 200 μL of the 100 pmol/μL solution into the scintillation vial 
to bring the final volume to 20 mL.

6. Mix this 1 pmol/μL solution thoroughly.

7. Label the vial Angiotensin I test solution and store it in a freezer until 
it is needed.
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Appendix A Miscellaneous Information

This appendix contains supplemental information for the previous 
chapters. It contains the following topics:

• “FT Analyzer Information in Scan Header” on page A-2

• “Data Size of FT Raw Files” on page A-4
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FT Analyzer Information in Scan Header
Use the Qual Browser window to open a raw file and to display scan 
header information for a selected scan in any of the cells. Choose View > 
Scan Header to display the Scan Header of the current scan in the 
active cell.

FT Analyzer Settings

The scan header information of an FTMS scan includes information 
about the FT Analyzer Settings that is not available in the usual Reports 
(Tune method, Instrument method, Status log, or Error log):

T=1e5 AGC Target for this scan (here: 1e+05)
PsIT=0.65 Prescan Inject Time (here: 0.65 ms)
Tog=(…) Manual diagnostic toggles are set different from 

their default values. See Table A-1 below for 
detailed information.

iWf Inject waveform on for this scan.
PvR=2e4 Preview analysis active for this scan 
DiagManualSettings Calibration parameters were manually changed 

under Diagnostics.

Table A-1. Actual settings of manual toggles

Tog = (…) Relevant Toggle Current setting Default setting

ApoOff FT apodization Off On

TrExp FT include transient On Off

FullP FT profile mode Full Reduced

IWFoff FT SIM and MSn injection 
waveforms 

Off On

Freq FT view frequency On Off 

Offset FT zero offset On Off
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FT Analyzer Messages

The scan header of an FT scan includes also so-called FT Analyzer 
Messages:

RF=1535V RF amplitude value (here: 1535 V)
HCD=148eV HCD collision energy in eV (here: 

148 eV)
Ufill=0.45 Maximum ion time reached. Here: the 

real number of ions is only ~45% of the 
target value.

MCal=4d Last mass calibration for this scan range 
is several days old (here: 4 days) 

Est=0x24 Machine-readable result message for 
post-processing tools

DAC=0.98 FT transient measurement near 
saturation, this might result in spectral 
harmonics (typically target value too 
high)

TCal=[195..] This is a hint that the current scan range 
settings for the FT analyzer are outside 
the calibrated storage/transfer mass 
range. Transfer parameters are 
extrapolated.

Lock=(inj524.3,1/1,+3ppm) Information about lock mass settings, 
extra SIM injection of lock mass ions, 
number of identified lock masses in the 
spectrum, and deviation of corrected 
(locked) masses compared to the external 
mass calibration.

Stable=15min Shows the elapsed stabilization time of 
the FTMS analyzer high voltage 
electronics after last off state or polarity 
switch. For best external mass accuracies, 
it is required to let the FTMS analyzer 
high voltage electronics stabilize before 
performing an acquisition or mass 
calibration.
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Note The actual FT Analyzer Messages can also be displayed in the Tune 
Spectrum view, see “Spectrum View” on page 2-3. ▲

Data Size of FT Raw Files
The data size of a raw file with FT data depends on many parameters: 
for example, on the number of scans, the resolution setting, and the data 
format.

Table A-2 below displays typical data sizes (per scan) of an FT spectrum 
(negative mode calibration solution, scan range m/z 120–1200, 
AGC target 5E5, 1 microscan, resolution setting 60000) at different 
FT data formats.

TempDiff=1 There is a temperature difference in the 
FTMS analyzer temperature between 
mass calibration time and current state. 
This may be caused by setting a different 
analyzer temperature setpoint in 
instrument configuration, by rapid 
significant changes in the ambient 
temperature, or by not waiting for 
temperature stabilization after 
instrument (temperature regulation) was 
off.

PkOvf Internal Peak detection overflow in the 
FT spectrum analysis

Table A-2. Typical data sizes (per scan) of an FT spectrum

FT Data Format Typical data size / scan 

Centroid ca. 10 kB

Reduced Profile ca. 20 kB

Full Profile ca. 2800 kB
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Glossary

This section lists and defines terms used in this guide. It also includes acronyms, metric prefixes, symbols, and 
abbreviations.

A

A  ampere

AC  alternating current

ADC  analog-to-digital converter; a device that converts 
data from analog to digital form.

adduct ion  An ion formed by the joining together of 
two species, usually an ion and a molecule, and often 
within the ion source, to form an ion containing all 
the constituent atoms of both species. 

AGC™  See Automatic Gain Control™ (AGC).

APCI  See atmospheric pressure chemical ionization 
(APCI).

APCI corona discharge current  The ion current 
carried by the charged particles in the APCI source. 
The voltage on the APCI corona discharge needle 
supplies the potential required to ionize the particles. 
The APCI corona discharge current is set; the APCI 
corona discharge voltage varies, as required, to 
maintain the set discharge current.

See also corona discharge and APCI corona discharge 
voltage.

APCI corona discharge voltage  The high voltage that 
is applied to the corona discharge needle in the APCI 
source to produce the APCI corona discharge. The 
corona discharge voltage varies, as required, to 
maintain the set APCI spray current.

See also APCI spray current.

APCI manifold  The manifold that houses the APCI 
sample tube and nozzle, and contains the plumbing 
for the sheath and auxiliary gas.

APCI needle, corona discharge  A needle to which a 
sufficiently high voltage (typically ±3 to ±5 kV) is 
applied to produce a chemical ionization plasma by 
the corona discharge mechanism.

See also chemical ionization (CI), chemical ionization 
(CI) plasma, atmospheric pressure chemical ionization 
(APCI), and corona discharge.

APCI nozzle  The nozzle in the APCI probe that sprays 
the sample solution into a fine mist.

See also atmospheric pressure chemical ionization 
(APCI).

APCI sample tube  A fused silica tube that delivers 
sample solution to the APCI nozzle. The APCI 
sample tube extends from the sample inlet to the 
APCI nozzle.

See also atmospheric pressure chemical ionization 
(APCI), and API stack.

APCI source   Contains the APCI probe assembly, 
APCI manifold, and API stack.

See also atmospheric pressure chemical ionization 
(APCI), APCI manifold, and API stack.

APCI spray current  The ion current carried by the 
charged particles in the APCI source. The APCI 
corona discharge voltage varies, as required, to 
maintain the set spray current.

APCI vaporizer  A heated tube that vaporizes the 
sample solution as the solution exits the sample tube 
and enters the atmospheric pressure region of the 
APCI source.

See also atmospheric pressure chemical ionization 
(APCI).

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
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API  See atmospheric pressure ionization (API).

API atmospheric pressure region  The first of two 
chambers in the API source. Also referred to as the 
spray chamber.

API capillary-skimmer region  The area between the 
capillary and the skimmer, which is surrounded by the 
tube lens. It is also the area of first-stage evacuation in 
the API source.

API heated capillary  A tube assembly that assists in 
desolvating ions that are produced by the ESI or 
APCI probe.

See also API heated capillary voltage. 

API heated capillary voltage  The DC voltage applied 
to the heated capillary. The voltage is positive for 
positive ions and negative for negative ions.

See also API source and API heated capillary.

API ion transfer capillary  A tube assembly that assists 
in desolvating ions that are produced by the ESI, NSI, 
or APCI probe.

See also API ion transfer capillary offset voltage and 
API ion transfer capillary temperature.

API ion transfer capillary offset voltage  A DC voltage 
applied to the ion transfer capillary. The voltage is 
positive for positive ions and negative for negative 
ions.

See also API source and API ion transfer capillary.

API ion transfer capillary temperature  The 
temperature of the ion transfer capillary, which should 
be adjusted for different flow rates.

See also API source and API ion transfer capillary.

API source  The sample interface between the LC and 
the mass spectrometer. It consists of the API probe 
(ESI or APCI) and API stack. 

See also atmospheric pressure ionization (API), ESI 
source, APCI source, ESI probe, and API stack. 

API spray chamber  The first of two chambers in the 
API source. In this chamber the sample liquid exits 
the probe and is sprayed into a fine mist (ESI or NSI) 
or is vaporized (APCI) as it is transported to the 
entrance end of the ion transfer capillary. 

API spray shield  A stainless steel, cylindrical vessel 
that, in combination with the ESI or APCI flange, 
forms the atmospheric pressure region of the 
API source. 

See also atmospheric pressure ionization (API).

API stack  Consists of the components of the 
API source that are held under vacuum and includes 
the API spray shield, API ion transfer capillary, 
API tube lens, skimmer, the ion transfer capillary 
mount, and the tube lens and skimmer mount. 

See also atmospheric pressure ionization (API) and 
API source.

API tube lens  A lens in the API source that separates 
ions from neutral particles as they leave the ion 
transfer capillary. A potential applied to the tube lens 
focuses the ions toward the opening of the skimmer 
and helps to dissociate adduct ions.

See also API tube lens offset voltage, API source, 
API ion transfer capillary, and adduct ion.

API tube lens and skimmer mount  A mount that 
attaches to the heated capillary mount. The tube lens 
and skimmer attach to the tube lens and skimmer 
mount.

API tube lens offset voltage  A DC voltage applied to 
the tube lens. The value is normally tuned for a 
specific compound.

See also API tube lens, adduct ion, and source CID. 

AP-MALDI  See atmospheric pressure matrix-assisted 
laser desorption/ionization (AP-MALDI).

APPI   See Atmospheric Pressure Photoionization 
(APPI).

ASCII  American Standard Code for Information 
Interchange

atmospheric pressure chemical ionization (APCI)  A 
soft ionization technique done in an ion source 
operating at atmospheric pressure. Electrons from a 
corona discharge initiate the process by ionizing the 
mobile phase vapor molecules. A reagent gas forms, 
which efficiently produces positive and negative ions 
of the analyte through a complex series of chemical 
reactions. 

See also electrospray ionization (ESI).
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atmospheric pressure ionization (API)  Ionization 
performed at atmospheric pressure by using 
atmospheric pressure chemical ionization (APCI), 
electrospray ionization (ESI), or nanospray ionization 
(NSI). 

atmospheric pressure matrix-assisted laser 
desorption/ionization (AP-MALDI)  Matrix-assisted 

laser desorption/ionization in which the sample target 
is at atmospheric pressure.

See also matrix-assisted laser desorption/ionization 
(MALDI).

Atmospheric Pressure Photoionization (APPI)  A soft 
ionization technique in which an ion is generated 
from a molecule when it interacts with a photon from 
a light source. 

atomic mass unit  Atomic Mass Unit (u) defined by 
taking the mass of one atom of carbon12 as being 
12u; unit of mass for expressing masses of atoms or 
molecules.

Automatic Gain Control™ (AGC)  Sets the ion 
injection time to maintain the optimum quantity of 
ions for each scan. With AGC on, the scan function 
consists of a prescan and an analytical scan.

See also ion injection time.

auxiliary gas  The outer-coaxial gas (nitrogen) that 
assists the sheath (inner-coaxial) gas in dispersing 
and/or evaporating sample solution as the sample 
solution exits the APCI, ESI, or H-ESI nozzle.

auxiliary gas flow rate  The relative rate of flow of 
auxiliary gas (nitrogen) into the API source reported 
in arbitrary units.

auxiliary gas inlet  An inlet in the API probe where 
auxiliary gas is introduced into the probe.

See also auxiliary gas and atmospheric pressure 
ionization (API).

auxiliary gas plumbing  The gas plumbing that delivers 
outer coaxial nitrogen gas to the ESI or APCI nozzle.

auxiliary gas valve  A valve that controls the flow of 
auxiliary gas into the API source.

B

b  bit

B  byte (8 b)

baud rate  data transmission speed in events per second

BTU  British thermal unit, a unit of energy

C

°C  degrees Celsius

CE  central electrode (of the Orbitrap analyzer);

European conformity. Mandatory European marking 
for certain product groups to indicate conformity with 
essential health and safety requirements set out in 
European Directives.

cfm  cubic feet per minute

chemical ionization (CI)  The formation of new 
ionized species when gaseous molecules interact with 
ions. The process can involve transfer of an electron, 
proton, or other charged species between the 
reactants. 

chemical ionization (CI) plasma  The collection of 
ions, electrons, and neutral species formed in the ion 
source during chemical ionization. 

See also chemical ionization (CI).

CI  See chemical ionization (CI).

CID  See collision-induced dissociation (CID).

cm  centimeter

cm3  cubic centimeter

collision gas   A neutral gas used to undergo collisions 
with ions.

collision-induced dissociation (CID)  An ion/neutral 
process in which an ion is dissociated as a result of 
interaction with a neutral target species. 

consecutive reaction monitoring (CRM) scan type  A 
scan type with three or more stages of mass analysis 
and in which a particular multi-step reaction path is 
monitored. 
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Convectron™ gauge  A thermocouple bridge gauge that 
is sensitive to the pressure as well as the thermal 
conductivity of the gas used to measure pressures 
between X and Y.

corona discharge  In the APCI source, an electrical 
discharge in the region around the corona discharge 
needle that ionizes gas molecules to form a chemical 
ionization (CI) plasma, which contains CI reagent 
ions. 

See also chemical ionization (CI) plasma and 
atmospheric pressure chemical ionization (APCI).

CPU  central processing unit (of a computer)

CRM  See consecutive reaction monitoring (CRM) scan 
type.

C-Trap  curved linear trap

<Ctrl>  control key on the terminal keyboard

D

d  depth

Da  dalton

DAC  digital-to-analog converter

damping gas  Helium gas introduced into the ion trap 
mass analyzer that slows the motion of ions entering 
the mass analyzer so that the ions can be trapped by 
the RF voltage fields in the mass analyzer.

data-dependent scan  A scan mode that uses specified 
criteria to select one or more ions of interest on which 
to perform subsequent scans, such as MS/MS or 
ZoomScan. 

DC  direct current

divert/inject valve  A valve on the mass spectrometer 
that can be plumbed as a divert valve or as a loop 
injector. 

DS  data system

DSP  digital signal processor

E

ECD  See electron capture dissociation (ECD).

EI  electron ionization

electron capture dissociation (ECD)  A method of 
fragmenting gas phase ions for tandem mass 
spectrometric analysis. ECD involves the direct 
introduction of low energy electrons to trapped gas 
phase ions.

See also electron transfer dissociation (ETD) and 
infrared multiphoton dissociation (IRMPD).

electron multiplier  A device used for current 
amplification through the secondary emission of 
electrons. Electron multipliers can have a discrete 
dynode or a continuous dynode. 

electron transfer dissociation (ETD)  A method of 
fragmenting peptides and proteins. In electron 
transfer dissociation (ETD), singly charged reagent 
anions transfer an electron to multiply protonated 
peptides within the ion trap mass analyzer. This leads 
to a rich ladder of sequence ions derived from cleavage 
at the amide groups along the peptide backbone. 
Amino acid side chains and important modifications 
such as phosphorylation are left intact.

See also fluoranthene.

electrospray ionization (ESI)  A type of atmospheric 
pressure ionization that is currently the softest 
ionization technique available to transform ions in 
solution into ions in the gas phase.

EMBL  European Molecular Biology Laboratory

<Enter>  Enter key on the terminal keyboard

ESD  ElectroStatic Discharge. Discharge of stored static 
electricity that can damage electronic equipment and 
impair electrical circuitry, resulting in complete or 
intermittent failures.

ESI  See electrospray ionization (ESI).

ESI flange  A flange that holds the ESI probe in 
position next to the entrance of the heated capillary, 
which is part of the API stack. The ESI flange also 
seals the atmospheric pressure region of the API 
source and, when it is in the engaged position against 
the spray shield, compresses the high-voltage 
safety-interlock switch. 
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ESI probe  A probe that produces charged aerosol 
droplets that contain sample ions. The ESI probe is 
typically operated at liquid flows of 1 μL/min to 
1 mL/min without splitting. The ESI probe includes 
the ESI manifold, sample tube, nozzle, and needle.

ESI source  Contains the ESI probe and the API stack.

See also electrospray ionization (ESI), ESI probe, and 
API stack.

ESI spray current  The flow of charged particles in the 
ESI source. The voltage on the ESI spray needle 
supplies the potential required to ionize the particles.

ESI spray voltage  The high voltage that is applied to 
the spray needle in the ESI source to produce the 
ESI spray current. In ESI, the voltage is applied to the 
spray liquid as it emerges from the nozzle.

See also ESI spray current.

ETD  See electron transfer dissociation (ETD).

eV  Electron Volt. The energy gained by an electron that 
accelerates through a potential difference of one volt.

Extensible Markup Language  See XML (Extensible 
Markup Language).

external lock mass  A lock that is analyzed in a separate 
MS experiment from your sample. If you need to run 
a large number of samples, or if accurate mass samples 
will be intermingled with standard samples, you might 
want to use external lock masses. These allow more 
rapid data acquisition by eliminating the need to scan 
lock masses during each scan.

See also internal lock mass.

F

f  femto (10-15)

°F  degrees Fahrenheit

.fasta file  extension of a SEQUEST™ search database 
file

ft  foot

Fast Fourier Transform (FFT)  An algorithm that 
performs a Fourier transformation on data. A Fourier 
transform is the set of mathematical formulae by 
which a time function is converted into a 
frequency-domain function and the converse. 

FFT  See Fast Fourier Transform (FFT).

fluoranthene  A reagent anion that is used in an 
electron transfer dissociation (ETD) experiment.

firmware  Software routines stored in read-only 
memory. Startup routines and low-level input/output 
instructions are stored in firmware.

forepump  The pump that evacuates the foreline. A 
rotary-vane pump is a type of forepump.

Fourier Transform - Ion Cyclotron Resonance Mass 
Spectrometry (FT-ICR MS)  A technique that 

determines the mass-to-charge ratio of an ion by 
measuring its cyclotron frequency in a strong 
magnetic field. 

fragment ion  A charged dissociation product of an 
ionic fragmentation. Such an ion can dissociate 
further to form other charged molecular or atomic 
species of successively lower formula weights. 

fragmentation  The dissociation of a molecule or ion to 
form fragments, either ionic or neutral. When a 
molecule or ion interacts with a particle (electron, ion, 
or neutral species) the molecule or ion absorbs energy 
and can subsequently fall apart into a series of charged 
or neutral fragments. The mass spectrum of the 
fragment ions is unique for the molecule or ion. 

FT  Fourier Transformation

FT-ICR MS  See Fourier Transform - Ion Cyclotron 
Resonance Mass Spectrometry (FT-ICR MS).

FTMS  Fourier Transformation Mass Spectroscopy

full-scan type  Provides a full mass spectrum of each 
analyte or parent ion. With the full-scan type, the 
mass analyzer is scanned from the first mass to the last 
mass without interruption. Also known as single-stage 
full-scan type.

FWHM  Full Width at Half Maximum
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G

g  gram

G  Gauss; giga (109)

GC  gas chromatograph; gas chromatography

GC/MS  gas chromatography / mass spectrometer

GUI  graphical user interface

H

h  hour

h  height

handshake  A signal that acknowledges that 
communication can take place.

HCD  See higher energy collision-induced dissociation 
(HCD).

header information  Data stored in each data file that 
summarizes the information contained in the file.

H-ESI probe  Heated-electrospray ionization (H-ESI) 
converts ions in solution into ions in the gas phase by 
using electrospray ionization (ESI) in combination 
with heated auxiliary gas.

higher energy collision-induced dissociation (HCD)  

Collision-induced dissociation that occurs in the 
HCD cell of the Orbitrap mass analyzer. The 
HCD cell consists of a straight multipole mounted 
inside a collision gas-filled tube. A voltage offset 
between C-Trap and HCD cell accelerates parent ions 
into the collision gas inside the HCD cell, which 
causes the ions to fragment into product ions. The 
product ions are then returned to the Orbitrap 
analyzer for mass analysis. HCD produces triple 
quadrupole-like product ion mass spectra.

high performance liquid chromatography (HPLC)  

Liquid chromatography in which the liquid is driven 
through the column at high pressure. Also known as 
high pressure liquid chromatography.

HPLC  See high performance liquid chromatography 
(HPLC).

HV  high voltage

Hz  hertz (cycles per second)

I

ICR  ion cyclotron resonance

ID  inside diameter

IEC  International Electrotechnical Commission

IEEE  Institute of Electrical and Electronics Engineers

in.  inch

infrared multiphoton dissociation (IRMPD)  In 
infrared multiphoton dissociation (IRMPD), multiply 
charged ions consecutively absorb photons emitted by 
a infrared laser until the vibrational excitation is 
sufficient for their fragmentation. The fragments 
continue to pick up energy from the laser pulse and 
fall apart further to ions of lower mass.

See also electron capture dissociation (ECD).

instrument method  A set of experiment parameters 
that define Xcalibur operating settings for the 
autosampler, liquid chromatograph (LC), mass 
spectrometer, divert valve, syringe pump, and so on. 
Instrument methods are saved as file type .meth.

internal lock mass  A lock that is analyzed during the 
same MS experiment as your sample and is contained 
within the sample solution or infused into the 
LC flow during the experiment. Internal lock masses 
provide the most accurate corrections to the data.

See also external lock mass.

I/O  input/output

ion gauge  Measures the pressure in the mass analyzer 
region (high vacuum region) of the vacuum manifold.

ion injection time  The amount of time that ions are 
allowed to accumulate in the ion trap mass analyzer 
when AGC is off. With AGC on, the ion injection 
time is set automatically (up to the set maximum ion 
injection time) based on the AGC target value. 

See also: Automatic Gain Control™ (AGC).

ion optics  Focuses and transmits ions from the 
API source to the mass analyzer.
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ion source  A device that converts samples to gas-phase 
ions.

ion sweep cone  A removable cone-shaped metal cover 
that fits on top of the API ion transfer capillary and 
acts as a physical barrier to protect the entrance of the 
capillary. 

ion sweep gas  Extra nitrogen gas that flows along the 
axis of the API ion transfer capillary (between the ion 
sweep cone and the capillary block) towards the API 
spray. The sweep gas flow is thus countercurrent to the 
flow of the ions. 

See also ion sweep gas pressure.

ion sweep gas pressure  The rate of flow of the sweep 
gas (nitrogen) into the API source. A measurement of 
the relative flow rate (in arbitrary units) to provide the 
required flow of nitrogen gas out from the Ion Sweep 
cone towards the API spray. 

See also ion sweep gas.

IRMPD  See infrared multiphoton dissociation 
(IRMPD).

K

k  kilo (103, 1000)

K  kilo (210, 1024)

KEGG  Kyoto Encyclopedia of Genes and Genomes

kg  kilogram

L

l  length

L  liter

LAN  local area network

lb  pound

LC  See liquid chromatography (LC).

LC/MS  See liquid chromatography / mass spectrometry 
(LC/MS).

LED  light-emitting diode

LHe  liquid helium

liquid chromatography (LC)  A form of elution 
chromatography in which a sample partitions between 
a stationary phase of large surface area and a liquid 
mobile phase that percolates over the stationary phase. 

liquid chromatography / mass spectrometry 
(LC/MS)  An analytical technique in which a 

high-performance liquid chromatograph (LC) and a 
mass spectrometer (MS) are combined.

LN2  liquid nitrogen

lock mass  A known reference mass in the sample that is 
used to correct the mass spectral data in an accurate 
mass experiment and used to perform a real-time 
secondary mass calibration that corrects the masses of 
other peaks in a scan. Lock masses with well-defined, 
symmetrical peaks work best. You can choose to use 
internal lock mass or external lock mass.

log file  A text file, with a .log file extension, that is used 
to store lists of information.

M

μ  micro (10-6)

m  meter; milli (10-3)

M  mega (106)

M+  molecular ion

MALDI  See matrix-assisted laser desorption/ionization 
(MALDI).

matrix-assisted laser desorption/ionization 
(MALDI)  A method of ionizing proteins where a direct 

laser beam is used to facilitate vaporization and 
ionization while a matrix protects the biomolecule 
from being destroyed by the laser.

MB  Megabyte (1048576 bytes)

MH+  protonated molecular ion

microscan  One mass analysis (ion injection and storage 
or scan-out of ions) followed by ion detection. 
Microscans are summed, to produce one scan, to 
improve the signal-to-noise ratio of the mass spectral 
data. The number of microscans per scan is an 
important factor in determining the overall scan time.   

min  minute
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mL  milliliter

mm  millimeter

MRFA  A peptide with the amino acid sequence 
methionine–arginine–phenylalanine–alanine.

MS  mass spectrometer; mass spectrometry

MS  MSn power: where n = 1

MS scan modes  Scan modes in which only one stage of 
mass analysis is performed. The scan types used with 
the MS scan modes are full-scan type and selected ion 
monitoring (SIM) scan type.

MSDS  Material Safety Data Sheet

MS/MS  Mass spectrometry/mass spectrometry, or 
tandem mass spectrometry is an analytical technique 
that involves two stages of mass analysis. In the first 
stage, ions formed in the ion source are analyzed by an 
initial analyzer. In the second stage, the mass-selected 
ions are fragmented and the resultant ionic fragments 
are mass analyzed.

MSn scan mode  The scan power equal to 1 to 10, 
where the scan power is the power n in the expression 
MSn. MSn is the most general expression for the scan 
mode, which can include the following:

• The scan mode corresponding to the one stage of 
mass analysis in a single-stage full-scan experiment 
or a selected ion monitoring (SIM) experiment

• The scan mode corresponding to the two stages of 
mass analysis in a two-stage full-scan experiment or 
a selected reaction monitoring (SRM) experiment

• The scan mode corresponding to the three to ten 
stages of mass analysis (n = 3 to n = 10) in a 
multi-stage full-scan experiment or a consecutive 
reaction monitoring (CRM) experiment

See also MS scan modes and MS/MS. 

multipole  A symmetrical, parallel array of (usually) 
four, six, or eight cylindrical rods that acts as an ion 
transmission device. An RF voltage and DC offset 
voltage are applied to the rods to create an electrostatic 
field that efficiently transmits ions along the axis of 
the multipole rods.

m/z  Mass-to-charge ratio. An abbreviation used to 
denote the quantity formed by dividing the mass of an 
ion (in u) by the number of charges carried by the ion.
For example, for the ion C7H7

2+, m/z=45.5.

N

n  nano (10-9)

nanospray ionization (NSI)  A type of electrospray 
ionization (ESI) that accommodates very low flow 
rates of sample and solvent on the order of 1 to 
20 nL/min (for static nanospray) or 100 
to 1000 nL/min (for dynamic nanospray). 

NCBI  National Center for Biotechnology Information 
(USA)

NIST  National Institute of Standards and Technology 
(USA)

NMR  Normal Mass Range

NSI  See nanospray ionization (NSI).

O

octapole  An octagonal array of cylindrical rods that acts 
as an ion transmission device. An RF voltage and 
DC offset voltage applied to the rods create an 
electrostatic field that transmits the ions along the axis 
of the octapole rods.

OD  outside diameter

Orbitrap mass analyzer  The Orbitrap™ mass analyzer 
consists of a spindle-shape central electrode 
surrounded by a pair of bell-shaped outer electrodes. 
Ions inside the mass analyzer orbit in stable 
trajectories around the central electrode with 
harmonic oscillations along it. 

Two detection electrodes record an image current of 
the ions as they undergo harmonic oscillations. A 
Fourier transformation extracts different harmonic 
frequencies from the image current. An ion's 

r

z
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mass-to-charge ratio m/z is related to the frequency f 
of its harmonic oscillations and to the instrumental 
constant k by:
m/z = k/f 2

OT  Orbitrap

See Orbitrap mass analyzer.

OVC  outer vacuum case

Ω  ohm

P

p  pico (10-12)

Pa  pascal

parent ion  An electrically charged molecular species 
that can dissociate to form fragments. The fragments 
can be electrically charged or neutral species. A parent 
ion can be a molecular ion or an electrically charged 
fragment of a molecular ion. Also called a precursor 
ion.

parent mass  The mass-to-charge ratio of a parent ion. 
The location of the center of a target parent-ion peak 
in mass-to-charge ratio (m/z) units. Also known as 
precursor mass. 

See also: parent ion.

PCB  printed circuit board

PDA detector  Photodiode Array detector is a linear 
array of discrete photodiodes on an integrated circuit 
chip. It is placed at the image plane of a spectrometer 
to allow a range of wavelengths to be detected 
simultaneously.

PE  protective earth

PID  proportional / integral / differential

P/N  part number

p-p  peak-to-peak voltage

ppm  parts per million

PQD  pulsed-Q dissociation

precursor ion  An electrically charged molecular species 
that can dissociate to form fragments. The fragments 
can be electrically charged or neutral species. A 
precursor ion (PR) can be a molecular ion or an 
electrically charged fragment of a molecular ion. Also 
known as parent ion.

precursor mass  Mass of the corresponding precursor 
(or parent) ion or molecule.

psig  pounds per square inch, gauge

PTM  posttranslational modification

pulsed Q dissociation (PQD)  Collision-induced 
dissociation that involves precursor ion activation at 
high Q, a time delay to allow the precursor to 
fragment, and then a rapid pulse to low Q where all 
fragment ions are trapped. The fragment ions can 
then be scanned out of the ion trap mass analyzer and 
detected. PQD eliminates the “1/3 Rule” low mass 
cut-off for MS/MS data.

Q

quadrupole  A symmetrical, parallel array of four 
hyperbolic rods that acts as a mass analyzer or an ion 
transmission device. As a mass analyzer, one pair of 
opposing rods has an oscillating radio frequency (RF) 
voltage superimposed on a positive direct current 
(DC) voltage. The other pair has a negative DC 
voltage and an RF voltage that is 180 degrees out of 
phase with the first pair of rods. This creates an 
electrical field (the quadrupole field) that efficiently 
transmits ions of selected mass-to-charge ratios along 
the axis of the quadrupole rods.

R

RAM  random access memory

raw data  Uncorrected liquid chromatograph and mass 
spectrometer data obtained during an acquisition. 
Xcalibur and Xcalibur-based software store this data in 
a file that has a .raw file extension. 

resolution  The ability to distinguish between two 
points on the wavelength or mass axis.

retention time (RT)  The time after injection at which 
a compound elutes. The total time that the compound 
is retained on the chromatograph column. 



Glossary: RF–SIM

G-10 Orbitrap Elite Getting Started (P/N 1288180, Revision A) Thermo Fisher Scientific

RF  radio frequency

RF lens  A multipole rod assembly that is operated with 
only radio frequency (RF) voltage on the rods. In this 
type of device, virtually all ions have stable trajectories 
and pass through the assembly. 

RF voltage  An AC voltage of constant frequency and 
variable amplitude that is applied to the ring electrode 
or endcaps of the mass analyzer or to the rods of a 
multipole. Because the frequency of this AC voltage is 
in the radio frequency (RF) range, it is referred to as 
RF voltage. 

RMS  root mean square

ROM  read-only memory

rotary-vane pump  A mechanical vacuum pump that 
establishes the vacuum necessary for the proper 
operation of the turbomolecular pump. (Also called a 
roughing pump or forepump.) 

RS-232  An accepted industry standard for serial 
communication connections. This Recommended 
Standard (RS) defines the specific lines and signal 
characteristics used by serial communications 
controllers to standardize the transmission of serial 
data between devices.

RT  An abbreviated form of the phrase retention time 
(RT). This shortened form is used to save space when 
the retention time (in minutes) is displayed in a 
header, for example, RT: 0.00-3.75.

S

s  second

scan mode and scan type combinations  A function 
that coordinates the three processes in the 
MS detector: ionization, mass analysis, and ion 
detection. You can combine the various scan modes 
and scan types to perform a wide variety of 
experiments. 

selected ion monitoring (SIM) scan type  A scan type 
in which the mass spectrometer acquires and records 
ion current at only one or a few selected 
mass-to-charge ratio values. 

See also selected reaction monitoring (SRM) scan 
type.

selected reaction monitoring (SRM) scan type  A scan 
type with two stages of mass analysis and in which a 
particular reaction or set of reactions, such as the 
fragmentation of an ion or the loss of a neutral moiety, 
is monitored. In SRM a limited number of product 
ions is monitored. 

SEM  secondary electron multiplier

Serial Peripheral Interface (SPI)  hardware and 
firmware communications protocol

serial port  An input/output location (channel) for 
serial data transmission.

sheath gas  The inner coaxial gas (nitrogen), which is 
used in the API source to help nebulize the sample 
solution into a fine mist as the sample solution exits 
the ESI or APCI nozzle. 

sheath gas flow rate  The rate of flow of sheath gas into 
the API source. A measurement of the relative flow 
rate (in arbitrary units) that needs to be provided at 
the sheath gas inlet to provide the required flow of 
sheath gas to the ESI or APCI nozzle. 

sheath gas inlet  An inlet in the API probe where sheath 
gas is introduced into the probe. 

sheath gas plumbing  The gas plumbing that delivers 
sheath gas to the ESI or APCI nozzle. 

sheath gas pressure  The rate of flow of sheath gas 
(nitrogen) into the API source. A measurement of the 
relative flow rate (in arbitrary units) that needs to be 
provided at the sheath gas inlet to provide the required 
flow of inner coaxial nitrogen gas to the ESI or APCI 
nozzle. A software-controlled proportional valve 
regulates the flow rate. 

See also sheath gas. 

sheath gas valve  A valve that controls the flow of 
sheath gas into the API source. The sheath gas valve is 
controlled by the data system. 

  signal-to-noise ratio (S/N)  The ratio of the signal 
height (S) to the noise height (N). The signal height is 
the baseline corrected peak height. The noise height is 
the peak-to-peak height of the baseline noise. 

SIM  See selected ion monitoring (SIM) scan type.
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skimmer  A vacuum baffle between the higher pressure 
capillary-skimmer region and the lower pressure 
region. The aperture of the skimmer is offset with 
respect to the bore of the ion transfer capillary. 

source CID  A technique for fragmenting ions in an 
atmospheric pressure ionization (API) source. 
Collisions occur between the ion and the background 
gas, which increase the internal energy of the ion and 
stimulate its dissociation. 

SPI  See Serial Peripheral Interface (SPI).

SRM  See selected reaction monitoring (SRM) scan 
type.

sweep gas  Nitrogen gas that flows out from behind the 
sweep cone in the API source. Sweep gas aids in 
solvent declustering and adduct reduction.

See also sweep gas flow rate.

sweep gas flow rate  The rate of flow of sweep gas into 
the API source. A measurement of the relative flow 
rate (in arbitrary units) to provide the required flow of 
nitrogen gas to the sweep cone of the API source.

See also sweep gas.

syringe pump  A device that delivers a solution from a 
syringe at a specified rate.

T

T  Tesla

target compound  A compound that you want to 
identify or quantitate or that a specific protocol (for 
example, an EPA method) requires that you look for. 
Target compounds are also called analytes, or target 
analytes.

TIC  See total ion current (TIC).

TMP  See turbomolecular pump.

Torr  A unit of pressure, equal to 1 mm of mercury and 
133.32 Pa.

total ion current (TIC)  The sum of the ion current 
intensities across the scan range in a mass spectrum.

tube lens offset   The voltage offset from ground that is 
applied to the tube lens to focus ions toward the 
opening of the skimmer.

See also source CID.

Tune Method  A defined set of mass spectrometer tune 
parameters for the ion source and mass analyzer. Tune 
methods are defined by using the instrument 
software’s tune window and saved as tune file.

A tune method stores tune parameters only. 
(Calibration parameters are stored separately, not with 
the tune method.)

tune parameters  Instrument parameters whose values 
vary with the type of experiment.

turbomolecular pump  A vacuum pump that provides 
a high vacuum for the mass spectrometer and detector 
system.

TWA  time weighted average

U

u  atomic mass unit

UHV  ultra high vacuum

ultra-high performance liquid chromatography 
(U-HPLC)  See high performance liquid 

chromatography (HPLC).

Ultramark 1621  A mixture of 
perfluoroalkoxycyclotriphosphazenes used for ion trap 
calibration and tuning. It provides ESI singly charged 
peaks at m/z 1022.0, 1122.0, 1222.0, 1322.0, 1422.0, 
1522.0, 1622.0, 1722.0, 1822.0, and 1921.9.

UMR  Universal Mass Range

V

V  volt

V AC  volts alternating current

V DC  volts direct current

vacuum manifold  A thick-walled, aluminum chamber 
with machined flanges on the front and sides and 
various electrical feedthroughs and gas inlets that 
encloses the API stack, ion optics, mass analyzer, and 
ion detection system.
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vacuum system  Components associated with lowering 
the pressure within the mass spectrometer. A vacuum 
system includes the vacuum manifold, pumps, 
pressure gauges, and associated electronics.

vent valve  A valve that allows the vacuum manifold to 
be vented to air or other gases. A solenoid-operated 
valve.

vol  volume

W

w  width

W  watt

WEEE   European Union Waste Electrical and 
Electronic Equipment Directive. Provides guidelines 
for disposal of electronic waste.

X

XML (Extensible Markup Language)  A 
general-purpose markup language that is used to 
facilitate the sharing of data across different 
information systems, particularly via the Internet.
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collision energy A-3
dynamics of ions 4-3
multipole 4-3
scan ranges 2-14
transmission 3-21

transmission calibration 3-21
transmission efficiency 3-18

HCD gradient 4-13
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